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GWIN %% FPGA 7~ fi: GWIN-1, GWI1N-2, GW1N-2B, GW1N-4,

GWI1N-4B, GW1N-6, GW1N-9

GWINR %% FPGA r~: GWINR-4, GW1NR-4B, GW1NR-9

GWINS %1 FPGA 7~ fi: GWINS-2, GWINS-2C

GW2A %% FPGA ;= fii: GW2A-55, GW2A-18

GW2AR %% FPGA 7= fi: GW2AR-18

GWI1NZ &% FPGA 7= /i: GWI1NZ-1
GWI1NSR %% FPGA 77 fii: GW1NSR-2C. GW1NSR-2

[ ]

1.3 3
R = 2 SR M L www.gowinsemi.com.cn B Rk, &E DL AH

KLY
GWIN £%1] FPGA 7= i Bl Tt
GWINR %% FPGA 7= 5 $ds Tt
GWI1NS %71 FPGA 7= 5 304 it
GW2A Z%1] FPGA 7= 5 B4 it
GW2AR %% FPGA 7= i 0 it
GWINZ %% FPGA 7= 5 34 T it
GWI1NSR %71 FPGA 7= 5 5048 7 it
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Gowin 8 F itttk 5 75t it
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PLL Phase-locked Loop BiFHIA
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Post-Synthesis Fiff TF2:

RTL THERHIA SO F P A B R0 5 9w 5 1) RTL Gt vk SO

Post-Synthesis T KA A2 H T RTL Wit @il 256 Ja 7 A &
A
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B 2-1 Gowin =R 5 &

|\ GOWIN FPGA Designer - [Start Page

. Hle Edit Tools Window Help _|=]x

= s RE1= 1O &

Recent Frojects:

Quick Start

IDEO706

D:\user-bakUsers\root\Desktop\1.8.1IDE\] —

fpga_project 3 [@ [= g
C:\Users\liyang01\Documents\fpga_project | New Project Open Project Open Example Project
fpga_project_1

CAU ng01\Documents\fpga_project |

Taol

fpga_project_2

CA\Users\liyang01\Documents\foga_project |

fpga_project ‘) %?é
Di\user-bak\Users\root\Desktoptest\fpga | Synplify Fro FloorFlanner Tining Constraints Editor
iodelay_127_125MHz

D\t \Users\root) \iedela

. User Manuals

impl_proj

C\Users\liyang01\Documents\impl_project)

pll_osc

D:\user-bak\Users\root\Desktop\sdctest\p

iser-bak\Users\roof\Deskiop\sdctestipl] Mamual for GHIN Mamual for GHZA
Start Page [x] ‘
Output g x

Mutput | Error | Warning | Info |

22 R #E

Gowin =B SCRFIE Ay B E BT, O B T SRR A

FEUNER 2-1 Fios.
£ 2-1 Gowin mIRBMAZRFHIS

k) LUT4s | Flip-Flops

MULT18 x 18

PLL

EIES

L

GWI1N-1 1,152 864

WLCSP30

QN32

QFN48

LQFN100

LQFN144

4/5/6

GW1N-2 2,304 1,728

16

WLCSP72

QFN32

QFNS8

QFN48

LQFP100

LQFP144

MBGA160

PBGA256

PBGA256M

4/5/6

GW1N-2B 2,304 1,728

16

WLCSP72

QFN32

QFNS8
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LUT4s

Flip-Flops

MULT18 x 18

PLL

ESEN

P

QFN48

LQFP100

LQFP144

MBGA160

PBGA256

PBGA256M

4/5/6

GW1N-4

4,608

3,456

16

WLCSP72

QFN32

QFN88

LQFP100

LQFP144

MBGA160

PBGA256

QFN48

PBGA256M

4/5/6

GW1N-4B

4,608

3,456

16

WLCSP72

QFN32

QFN88

LQFP100

LQFP144

MBGA160

PBGA256

QFN438

PBGA256M

4/5/6

GWI1NR-4

4608

3456

16

QFN88

MBGAS81

4/5/6

GWI1NR-4B

4608

3456

16

QFN88

MBGAS81

4/5/6

GW1N-6

6912

5184

20

LQFP144

UBGA332

PBGA256

LQFP100

QFN88

QFN48

LQFP176

MBGA160

WLCSP64

UBGA256

4/5/6

GW1N-9

8640

6480

20

LQFP144

UBGAS332

PBGA256

LQFP100

QFN88

QFN48

LQFP176

4/5/6
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LUT4s

Flip-Flops

MULT18 x 18

PLL

ESEN

P

MBGA160

WLCSP64

UBGA256

GWI1INR-9

8640

6480

20

LQFP144

QFN88

4/5/6

GWI1INS-2

1728

1296

WLCSP36

QFN32

QFN48

LQFP144

QFN32U

4/5/6

GWINS-2C

1728

1296

WLCSP36

QFN32

QFN48

LQFP144

QFN32U

4/5/6

GW1NZ-1

1152

864

WLCSP16

QFN32

4/5/6

GWI1NSR-2

1728

1080

QFN48

4/5/6

GWINSR-2C

1728

1080

oo

QFN48

4/5/6

GW2A-18

20,736

15,552

48

PBGA484

PBGA256

LQFP144

PBGA256S

MBGA196

6/7/8

GW2AR-18

20,736

15,552

48

QFN88

LQFP144

LQFP176

eLQFP144

6/7/8

GW2A-55

54,720

41,040

40

PBGA484

PBGA1156

6/7/8

!

BAFRRAAE, SRS

N

WRERIEE R, FARE RIS KBTI .
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3 WA A 3.1ia173E

LR RE

3.1 BITHE
Windows: Win7/8/10(64bit). XP(32bit)

Linux: Centos6/7(64bit). Red Hat 6/7(64bit). SUSE 11/12(64bit)
3!
H i A 3 FF linux Centos5.

3.2 RHTH

Gowin VR #2235 4,45 Windows IlRAS AT Linux s, 7] 3@ i & 5t s

= R AT Nk

® Windows #4: FHIZEEL LN “Gowin Yunyuan for
win(Vx.x.xbeta)” , T#k: www.gowinsemi.cn/fag.aspx

e Linux fRAZE4EEFEN, “HN “Gowin Yunyuan for
linux(Vx.x.xbeta)” , T#E3AE: www.gowinsemi.cn/fag.aspx

bEy

o ERMFNEGET, FWABTEMEMIFER.

o B wRAUEMELIR “Vxx.xbeta” H “x” RRBMRIRAS .

ey o)
3.3 MHEREK
!

o % Gowin mUREATAET, ZUKH 360 B LL# 5 SR A

o IR RRAT M AN SCRE S TP SCEU AR (R SR AR

o T LRHIRA Gowin ZIREAMF, U EARA LG, HIREE,
e  Windows T ZASFFIEF LMy, AR A WK 3-1 Fios.
# 3-1 Components to Install

Components g Bk

Gowin YunYuan | Gowin ZVFEEAFETER | %R AT AT SCHEAE 3 H 3R
GUI PR \X.X\IDE\bin\gw_ide.exe
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3 w2 3.3 B2
Components ik #E
® A JR AT B AR L AT AT SO
Gowin i 52k T A 1 f’z%?i?\x.i(\Pnr\bin\g?win.exe;
Pnr tool FERAET 2L . IBS R A 2 B 42 X X\Pnlibs
SCAFRABIRIFARSCS | @ IBS B S fF %\ X\PRnibs:
AR A SG SCR R AR\ X\Pnndoc
® NN HAT I AE LR H R T
_ Gowin BT #H T A, 4 \x.x\Programmer\bin\programmer.e
Eﬁ)\gf:mmer % programmer i F 3¢ X€;
= ® X A SRS AR
\x.x\Programmer\doc.
® R AIHAT SCAFE LB AR T
\X.x\SynplifyPro\bin\synplify_pro.ex
SyplifyPro for Gowin 2 T H, L FE A e
Gowin FHSCRY
® OIS FH SO B AR
\X.x\SynplifyPro\doc.
i 1 E 4 o 7 [ 4T3 AR
Floorplanner Eowm W 2R e T N R HAT SCHRE 2B H
73 \x.x\Floorplan\bin\floorplan.exe
VE!
KM “xXX” R PR
Windows 3%t
£ Windows 2 4i %% Gowin =E#E, iE3% L N HR.
1. WilrZedetn, MRIFRRBIN 222,
E!
o AR AT AR Y 7 B U H
o IBHINLIE, KB PC SMAIE I <R,
2. MadrpsEsr A “BE7, $THF Gowin =Rk S .
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3 mRHAT 2%

3.4 BAEVE AT IE ingk (Windows)

Linux &%

£ Linux R4 T, MEESCERIE, UL root BUBRIEAT 4 K r 4
path/x.x.xBeta/IDE/bin/gw_ide, BIA] 4T #4F St .
!
“x.x.xBeta” H “x” RRPAFMIRAS .
!
W P 22320 Gowin =iEEAE, Fkz$ s, TN SynplifyPro £5& TH A FH AT
S i) Gowin =R EAF I L B AR R AL T [F— X, BB T
1. fEZHAFH, Hdi “Tools > Options”;
2. i&F¥ SynplifyPro )z d%ikts, il 3-1 fros.

. N 2
& 3-1 SynplifyPro A&
S Options *
Synthesis
%, Environmen t Synthesis
= Synplify Pro:
—  Text Edit
®) Default (Synpify Pra for GOWIN)
f' External Editor ) Custom
€5 Synth Path: | C:/Synoy A Brov
[*]items request restart GOWIN FPGA Designer Cancel Apply

3.4 M FATIEMEL (Windows)

SUG100-1.5

LB 5, FME IS ATIE (License) A BE1EH TA4E, Gowin
R Y AT IE RS -
e SynplifyPro Zi& TR AE;
o fiJRAT L T HAVFATE .

Gowin z IR AT IE SZFE 1 S 8 2 W RTIE (Node-Locked License)
s ATE (Floating License ).

BB FE =k S E W www.gowinsemi.cn/fag view.aspx HiE
License.

A ATIEAR N # J7 v 5 2% 3.5SynplifyPro License IN#k & 3.6 Afi
Jaifi 2k T.H License hn#k.
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3 IR 3.5SynplifyPro License fn#k

3.5 SynplifyPro License J#y
3.5.1 1 R EVFATE

TR AR R T AL MAC Huhik BT BRI AT e, AN BR AL
it . Y3 SynplifyPro 7 i BUE VFATIESG , 125 DL T PR3
*E!
#1"C:\Synopsys\"B 1% et ki TH, FLBE T4 license X, 2 55 Gowin i) synplify
1E34K license B I . [K 2 synopsys 2= BRIN G BX AN 842 T 4K license, A
RO EREAL &,
1. BURBLwin7, 64 fiifE RGAH, E RGN ELE.
1. {#4F License {4
F3R15 1 SynplifyPro 1] License ({4 (U licensefile.txt) {RA77EFE E H
&K, 40 “E:\Synopsys\licensefile.txt” .
2. MEENETE.

a). Ak “UFEA , EE CRaENT , Bl ‘ERRARRE,
T “RGEH” w1,

b). fE“RGEM"T O Bl m A, B R AR RS H A, I
AP AREUENE, WK 3-2 frs, 7T PR B E i
NI B 4 A AR e AE s

- T EAFR: LM_LICENSE_FILE;
- AFEfH: License AR FINALE, W“E:\Synopsys\licensefile.txt”.
3. il “HhE”.

B 32 FETERE
' EmEe 5
iENE [EE BB | Feein me |
HEEE 23
(emr=s =
TR IM_LICEASE_FILE|
TEHE V) E:%Symopsysiilicensefile. tut
[ me | =mE |
N —
FETEE (5)
T8 i8 it
ACTEL FOR_AL. ..
ALTERA_FOR_A. ..
ComSpec C:hWindowshsystem3Ziomd. exe
FFP_HO HOST w1 S
(FEw... | [(®Eo.. | [ #Wo |
= [ ®e | EH | |D
N AY -
3.5.2 EENFANE

ANV IR AR R A — G VAT IE IR S5 45, R ) PC #R]
. Bl AE S A AP BB R
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3 IR 3.5SynplifyPro License fn#k

=

JRENFE Y AEARS:, F 4% Synopsys Common Licensing (SCL) %
fF, BREAE 223540 R 3% “GowinLicenseServerForwindows\SCL”,

a). B SCL #7301 “scl_v2018.06_windows.exe” #4T SCL
A2 RE, W3 m SR AT 248, TR “Site
Information” Fi [ A #EAT W1 AL E :

- “Site ID”:3%15 ¥ SynplifyPro [ License {4 (41 synp_license.lic) ]

“siteid” HIHUE, 129247,

- “Site Administrator”: & AHLE P LR
- “Contact Information”: w[i%3EI, & AECR TR

b). ARG B 228 n) Sk B L i, IRk L
“C:\Synopsys\SCL”, miii ~—Z HEIHI e A m,
“Completing the SCL 2018.06 Setup Wizard”, xiidi “Finish” 1%
Hl5E Rk SCL 223k,

2. 1F SCL Z#:ig42 FHEANFISCFJ “2018.06\win32\bin”, 11

“C:\Synopsys\SCL \2018.06\win32\bin”, & /#7528 5504 vl ik

R%, LAWIin7, 64 fiffE RSG5

o MmATHF

a) BIEshE AT IE S/ (i synp_license.lic) &5 4 SCL 223
HAAET;
b) MBSO BV RSO BT EALAA FR AN MAC ik,
il
license LN “SERVER hostnamel F8BC12950972 27020”
- “hostnamel” NABSCNANLITEHLLFK;
- “F8BC12950972” JNAHNLK] MAC Hikit;
“27020” Mm-S, R¥EZEE SynplifyPro fTHENLE BT E%: W
B 5 H“SERVER GaoYun-PC F8BC12950972 270207,

SUG100-1.5 11(79)



http://www.ebookee.net/Synopsys-Common-Licensing-SCL-11-7_3446803.html

3 mRHAT 2%

3.5 FHAE

SUG100-1.5

S:

[F< T T~ TR+ RV Y+ N T T R T T T T < R NV RV T T < T BT+ RV BV BT« R

16:
:la:
t16:
16
l6:
16:
16:
l6:
16:
16:
l6:
16:
16:
l6:
16:
16:
l6:
16:
16:
l6:
16:
lé:
l6:
:16:
:le:

® SCL Ffft Ef
BB VERIESCHE (W synp_license.lic) &I A SCL 2z 34 %

c) EHUFBNERIE S snpsimd 4%
R SCL #Frh snpsimd.exe 1%, & license U1

d)

“VENDOR snpsimd /path/to/snpsimd” —1T, tf&&s A~
“VENDOR snpsimd
C:\Synopsys\SCL\2018.06\win32\bin\snpsimd.exe” ;

T cmd

W,

54T

BAT e BBV RTIE RS, BTSN

“path\Imgrd.exe” —c “path\licensefile” —I “path\logfile” —
z-s;
e) Bfrseke)E, AF log X (log XfF#4%: path\logfile), #fiiA

License s& 5 222 2, W22,

N2 o

log 32> L N & 3-

B 3-3 License &3 1) log A

G e eMa e aUeuN LA
01/28/2019 09:16:06 (snpslmd) W
01/28/2019 09:16:06 (snpmslmd)

29247, SErzerm 525400B8ABET7, Issued on: 12/18/2018

06 (snpslmd) SLOG: Statistics Log Frequency is 240 minute(s) .

06 (znpslmd) SLOG: TS5 update poll interval is 0. TS5 update is detected by midnight reread only.
06 (znpslmd) S5LOG: Activation borrow reclaim percentage is 0.

06 (sapsled) (Bsnpslmd-SLOGE)

06 (snpslmd) (@snpslmd-5LOGE) == Vendor Daemon ===

06 (znpslmd) (@snpslmd-S5LOGE) Vendor daemon: gnpslmd

06 (zppsimd) (Esnpslmd-SLOGE) Start-Date: Mon Jan 28 2019 09:16:06 CST

06 (sppslmd) (Bsnpslmd-SLOGE) PID: 30659

06 (gnpsimd) (@snpslmd-SLOGE) VD Version: wll.14.1.3 build 212549 x64 lsb ( build 212549 (ipvé))
06 (gopsimd) (Gsnpslmd-SLOGE)

06 (znpslmd) (Bsnpslmd-SLOGE) === Zgartup/Restart Info ===

06 (gnpsimd) (@snpslmd-SLOGE) Options file used: None

06 (znpslmd) (Esnpslmd-SLOGE) Is vendor daemon a CVD: Yes

06 (snpslmd) (E€snpslmd-SLOGE) Is TS accessed: No

08 (snpslmd) (Esnpslmd-SLOGE) TS accessed for feature load: -NA-

06 (snpslmd) (@snpslmd-S5LOGE) Number of VD restartcs since L5 ghartup: 0

06 (snpsimd) (@snpslmd-SLOGE)

06 (znpsind) (Bsnpslmd-SLOGE) === Network Info ===

06 (snpslmd) (@s3npslmd-5SLOGE) Listening port: 37814

06 (snpslmd) (E€snpslmd-SLOGE) Daemon select gfimeout (in seconds): 1

06 (gnpslnd) (Bsnpslmd-SLOGE)

06 (gnpslmd) (@snpslmd-SLOGR) === Host Info =——

06 (snpslmd) (@snpslmd-SLOGE) Host used in license file: gwligense

06 (2npslmd) (@snpslmd-S5LOGE) Running on Hyperwisor: Mot determined - treat as Physicaﬂ
06 (snpsimd) (Esnpslmd-SLOGE)

a)
b)
c)

d)

(E

BE

BNVFRTUE SO i BT AL FR KA MAC Huhik, 7] &% iy

AT L IR b);

/; C);

FI7R s

1'4‘&/%3314?7%1#435’] snpsimd 4%, W &E TR E

f£ snpsimd 42K, HIE 3447 3 Imtools.exe, FLanF 3-
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3 mIR s 3.5SynplifyPro License Jn#k

& 3-4 SCL B3 A

LMTOOLS by Flexera Software LLC - X
File Edit Mode Help

Service/License File 1 System Settings | Llilties 313 | Server Status | Server Diags ] Corfig Services ] Bomowing I

FlexNet license services installed on this computer

Start Server ‘ Stop Server ReRead License File

) ) ™ Force Server Shutdown
SR ErEeTEE MNOTE: This box must be checked to shut down a license server

when licenses are bomowed

‘Uswng License File: C\ProgramData‘\Mational Instrumentstlicense Manager'\licenses

e) % “Config Services” T4, fit B A& {42, i 3-FR:
- “path to the Imgrd.exe file” : Imgrd.exe S FFT{EH1Z;
- “Ppath to the license file” : license /e 42
- “Pathto the debug log file” : %k license J5 4 i) log S B8 A2 G
G log SCfF, FECE R EE—A log X,
A 3-5 SCL L& 5

LMTOOLS by Flexera Software LLC [= )= =]
File Edit Mode Help

Service/License File | System Settings | Ltilities | Start/Stop/Reread | Server Status | Server Diags  Config Services | Bomowing |

Save Service
Remave Service

Configure Service

Service Name |N|LM License Manager ﬂ

Path to the Imard.exe file |C A\SynopsyshSCL'2018.06'win32\bin‘Imgrd exe M

- —— - — B
Path tathe licensefle  |C-\Synopsys\SCL'\gowin_Synplfypro_54EE753: ronse

Path to the debuglog file  |C-Synopsys\SCLAmgrd log Browse | View '—09---|

[~ Start Server at Power Up v Use Services I™ FlexMNet Licensing Service Required

The HexMet Licensing Service is required for optional
features such as virttualization and trusted storage.

2. WETE, BahvFaliEiks, Wk 3-Fiw, &# “Start/Stop/Reread”
JI%, By “Start Server” , AI{E R~ “Server Start Successful”
WK B8 WAl EE log & E RSB, stk
3-#11 View Log A] & log 31

SUG100-1.5 13(79)




3 IR

3.5SynplifyPro License Jn#k

SUG100-1.5

Kl 3-6 SCL J83 license 1

LMTQOOLS by Flexera Software LLC =] =@ ==
File Edit Mode Help

ServicesLicenze File | Syztem Settings | Utiities ~ Start/Stop/Reread | Server Status | Server Diags | Config Services | Barrawing |

FlexMet license services installed an this computer

Start Server | Stop Server | ReRead Licenze File
i i [ Force Server Shutdown
Edit Advanced selfings MAOTE: Thiz box must be checked to shut down a license server

when licenses are borrowed.

Server Start Successful |

!

JABIRSS VFATIEIRSS 2 5, FFFRACE RANIFELE LM_LICENSE_FILE 74 1] s Ihn#k

SynplifyPro ¥ AT iE. W& 3-Fr:

e FE#. LM_LICENSE_FILE;

o FHE{H: License CHFMIfFAIE, Ww: “27020@192.168.31.33” , Hr
“192.168.31.33” NANLA IP Huihl.

K 3-7 R IREERE

EEERE =

|itEnE | #iE | =R (R [EE |
wEEE - =

Adninistrater MIFFZE WD

[
i B
SEErEE =
TEEm: IM_LICEHSE_FILE
TEFHWV: 270208192, 165 31. 33
C @z | mE |
! =
ELyE) =]
_DFY_THSTAIL. .. 1
MtiamPath C:"Program Files'Altium Desigme. ..
ComSpec CoWindows'isystem3Zhemd. exe
FP_HO HOST I Hn ke
(FrEm. . | [FmEo. . | [ #Eo |
- [ we [ mE || U
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3 IR 3.6 i JHA Lk T H. License Jn#k

3.6 Ta /% T A License N#;

Gowin =R 22 38 52 1 G, $T T = IR B AL I 2% License #47 check,

Wi License A IEAf N EAL TCiEFT 4 B Error 32754, W 3-Fios.
& 3-8 License Error &~ 1E

way Error . e

'8' License check failed, please check your settings.

Gowin =R 2352 il G TR EC & License {5 5., SRR

1. FT7T Gowin Z JE#A4 5 ;
2. fERHFLE, Hii “Help> Manage License...” , 3! “License
Configuration” & 1, #1& 3-A1R.

& 3-9 Manage License 3%

P N
Wy License Configuration @

License Config

) Uze Local Licenze File @ Uze Floating Licenze Server

Server: 192 . 188 . 31 . 220 Port: 10559

Apply for License [ Save ][ Cancel

3. FH Pk RAHE License SCHEELIES) License LA
® Use Local License File
IR FEA M node-locked License ({4, H.idi “Browse...” , IS
BAZ
Ve
I License X, i “License Configuration” % 14 R J5 “Apply for License”
Hig .
® Use Floating Licese Server
JASEF BN AIEARSS, 7513 ] PnrLicenseServer B4, B#k {300
A “GowinLicenseServerForWindows\PnrLicenseServer”. #J il it
PA NP FP 7 X8 3 PnrLicenseServer:
a) HEXNS “gwlic_server.exe” B3:
B BIEsh Y AT UE SCf: (i gowin_license.lic) & #15

SUG100-1.5 15(79)




3 wIR A3 3.6 i JHA Lk T H. License Jn#k

“GowinLicenseServerForwWindows\PnrLicenseServer”, ¥z
AE 4y “gowin.lic” , Xk “gwlic_server.exe” ;

b) a1 TEIUE3)
- EHRREFSh VR AESCHE (4 gowin_license.lic) il F

“GowinLicenseServerForwWindows\PnrLicenseServer”, 7t cmd % I

i gwlic_server.exe AT {E#$ 1% T in 23047 : gwlic_server.exe — license.txt.
- JEshEwE 3-Fis.
/& 3-10 Gowin Floating License Server J& ) 1

R BEER: Ch\windows\system32\cmd.exe - gwlic_server.exe -l C81F6626CIA5 floating.lic |5@é

:48 > loading license...

tool: gowin, limit: 18, expired date: 2816-85-25
:48 > starting server...

Host—id: CB1F6626C?AS

IP Address:

Listening Port: 18559

server started, waiting for connection...

- JBEIRIhZ G, fE“Licese Configuration” % I 346 AR S5 25 1) 1P Hidik,
' 3-3 Fiors
B 3-3 Floating License EC& 5 1H

-
{y License Configuration I&J
License Config
Use Local License File @ Use Floating License Server
Server: 192 . 188 . 31 . 220 FPaert: 10559 Test Connection
Apply for Licsnse [ Save || Comeel |
| %

- il Test Connection %41 AT LA RE 1538 #E ), BRI = AE
License Configuration % I+ I successed, #1K 3-12 ffiis.

SUG100-1.5 16(79)




3 IR 3.6 fii i £k T H License Jin#;

B 3-4 R

Ay License Configuration Iﬁ
Licenze Configz
() Use Local License File (@ Use Floating License Serwer
Serwer: 192 . 168 . 31 . 220 Fort: 10550
Succezsed
1|
fpply for License | Save || Cancel
b i —— e —— = = )

SUG100-1.5 17(79)




3 mRHAT 2%

3.7 FAFVFATIE N #K (Linux)

A Y A3 A3 .

3.7 R IFAEME (Linux)
3.7.1 SynplifyPro License JiN&Y

Linux ¥4 1) SynplifyPro & Floating License 287, 41i 3|
SynplifyPro [ License J&, ¥ license.txt SCHARAEAE Imgrd #5422, TRELE
HE 2 N license.txt I, SR 465 B/ A%

Linux £ 45 LA 64 4i7 Linux £ 4;, Redhat 5 A T 3 #F floating license
ZAe, HZH U N BERPATINEIE IR
1. 32 “GowinLicenseServerForLinux\SCL\Synopsyslnstaller” T,

4 “installer_INSTALL_README.txt” 2R, %%
“Synopsysinstaller”:

SUG100-1.5

a)

b)

d)
2

£ Synopsyslinstaller_v4.1.run SCHB AR, AB SRR LR 1T A

i, AT 44T, 847 “chmod 755

Synopsysinstaller_v4.1.run”,

P14 % root ALK, 7E Synopsysinstaller v4.1.run 4% N34T 235 6y

AR “./Synopsysinstaller_v4.1.run -d /usr/synopsys/installer”.

IR root AUPR, PR ZARERACFT LMER, £ 4 AT 812347 : “chmod

-R 755 /usr/synopsysl/installer”,

- IR

- 42 Cshell, &17:

- “set path=(/usr/synopsys/installer $path)”

- 42 Bourne 5 /& Bash shell, Niz47:
“PATH=/usr/synopsys/installer:$PATH”

- “export PATH”

Al LA “export”$84 E I AR &, AN PATH 2 5.

RE “GowinLicenseServerForLinux\SCL\doc” K]

“scl_INSTALL_README.txt” #1T SCL i fh%eds, 2 Eu “path/
scl_lic_server_linux/v2018.06”:

a)

b)

W2 suse R5t, NIMIER “GowinLicenseServerForLinux\SCL” 1]
“scl_v2018.06_linux64.spf” i, R EHA RS (CentOS,
Redhat, UBUNTU %), NIMIE: “scl_v2018.06_suse64.spf” 14
TE4 %5 0T Synopsysinstaller 2 5, %% SCL #fF, HATm4:
“installer -batch_installer -source <SOURCE> -target <DEST>"
<SOURCE>Jy spf SCF k4%, <DEST>H %% SCL HAF M2 .
IR S FRIA SR AR IR 223, T “yes” 4k
B,
A IE GRS R license SCAH:
B AL R A MAC Hitik
7t floating license SCfFHf, K “SERVER hostnamel
000C293B1A2B 27020” N % hostnamel (E°h R EHL 4,
000C293B1A2B iy HWaddr, 27020 Jyiii 15, # 4 %% SynplifyPro
I HHUE BT B8, W “SERVER gaoyun 000C293B1A2B
27020” ;
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3 mRHAT 2%

3.7 FAFVFATIE N #K (Linux)

b) &k snpsimd 1%
5 SCL & A snpsimd (#8412, ¥ license {41 “VENDOR
snpsimd /path/to/snpsimd”—17, B NAM: snpsimd (] #81%,
“VENDOR snpsimd
path/scl_lic_server_linux/v2018.06/linux64/bin/snpsimd”.

4. f§iH SCL jn#k License:

7E Imgrd 42 N 4T84 /Imgrd -c license.txt -l lic.log”, “ER% log 14

lic.log, &% lic.log SCHFRAV T INELL), WnE Y, log CAFH4

LT 3-N %

5 MENEASR:

a) WEAEAE LM_LICENSE_FILE, HAHM#RN “i 5 @3l
4” . . setenv LM_LICENSE_FILE 27020@gaoyun.

b) License z3EidfEdy, BRINKH 27020 i 11, F 7 7] 4% License ik
ek, B st: #T7F License UM, 4K “27020” F4FE, F
AN TR E i .

!

H K license MIEAETR 24U, FrE 12 391E license 2250 H 3 FHUAT:
e l# license—— “./Imgrd —c licensefile - lic.log” ;

e (£ license—— “./Imdown -c licensefile” ;

e T license A “ imstat -a -c ¥ E5@FENL”

3.7.2 Tk LA License jNE;

SUG100-1.5

Linux ¥#3% T Gowin License Bn# it #25 Windows 185 N[, 15S

# 3.6 fi 4k T H License fn#L.

19(79)




4 BYFHAT A S 4.1 bt

R EGH PR

ﬁ%ﬁ#%?ﬁﬁ@ﬂ4&%%,iﬁ“%ﬁ@ﬁ SERARE . T HEFE,
THEFX (Design &), M FIX (Process &) Y-t IX o
5 BHH X (Output).

B 4-1 FAEH P S E

2)

{ GOWIN FPGA Designer - [D: Desktop\L 8 1IDEIDEO70! g - B e e e - [E=EE )
Fle Edit Project Tools Window Help =[x
3 <
Design Bx|[ L R R AR ARA AR R AR R AR AR R AR R AR R AR R AR A AR R AR R AR AR R AR R AR AR DA AR AR AT DA AAE R A ®
4 7 IOROT0B - (D \user-baklUsersios 4 2 Physical Constraint file
[E] 6win-LvapG2s6ee/1s 3 Version:1.8.1Beta
Verilog Files 4 Created Time: Wed Aug 15 14:56:28 2018
4 testy 5 Device: GWIN-9
Physical Constraints 6 Package PBGAZ56
IDENT0G cat T oAk A kA kR A AR AR R A AR A AR R AR A AR R AR A AR A AR R AR KR AR AR AR AR R DA R AR AR AR A D Ak kD 5
[Process 8 x " "
B Design s 8 IO LOC "a[0]" B9, AlO;
esign Summar
- o e 9 INS 1LOC "out reg[0]" R17C15;
4 [ User Constraints 10 - - -
FloorPlanner
Timing Constraints Editor
Place & Route
Place & Route Report
Timina Analvsis Reoort Start Page L Dasign Sunary ] TOROTOB. cst o |
output & x
Info
Ing
Inro
Inf
Ing
Info
Ing
Info *IDEO706.power.html' file compleced.
Info (CHO 0 'IDEQ706.tr.heml' file completed.
Info TDE, pt.tat! file completed.
Info (= 8

T A |

ET AT
TREMIK
SRR HX

@)
ﬁ
@®E

® /J?I#Fﬁéfbﬂil:
@ ER&EHIX

4.1 FREt=

S N [T 1) 5 EoNE Y O =T TE A AR U Y

4.2 SEHE=

TGRSR A TR R RS LH, B4 File. Edit.

SUG100-1.5 20(79)




4 IRPAT L S

4.2 AL

SUG100-1.5

Project. Tools. Window Al Help &30, &0

e 6 6 LW e 66606 6 06 06 06 V>0O0 6 06 06 0 0 0 0

O e 00 0000 UT 000006000 00

File ZFf:

New, f T SCAFF1 TR B i s

Open, XT3 A-AT TR HIAT T

Save, PRAFELIAF TAEH S

Close, XM TAEE#E TREH RIS, DU,

Print, #TE[l

Recent Files, 4T H3CH, o] CLE Bt AT 4T 7T
Recent Projects, i) A, Al DAEHik£E4T 7
Exit, AR

Edit S 54

Undo, J#lH;

Redo, FEAfl;

Cut, BiJ;

Copy, Eiil;

Paste, fhllfi;

Select All, E#H4HEE;

Find, 740 e oC 5t ;

Macros, 7.

Project 2542

New File, T 3CHFHEE;

Add Files, ¥#snsCff;

Clean, &R, JEBR TREIEAT 5 impl SCEEIE TR A S mI B SO BLR ST
¥

Set Device, H#4 4T T device. package Al speed;
Configuration, THEHATEREFHIBLE.

Tools LA

Start Page, HiH7T;

Synplify Pro, #ii%E & 54

Simulation, 1/ ;

IP Core Generator, |IP Core ;= #;

FloorPlanner, ¥)¥ 2 m4E 4

Timing Constraints Editor, 5215 44 2%

Gowin Analyzer Oscilloscope, &z 7EZZ 5 HT1X;
Options, H P AI{ESAL BEFT AN T R B % & IDE 40,
Window 32 Ff%:

Full Screen, 45t ER;

Tile, “FHHER;

Cascade, 7 & 7n;

Reset Layout, KE V41 HE ;

Panels, X 5T A #% [X 38w e BB () e 45 5

Start Page, {3 1F4w%R X 7~ Start Page;

Design Summary, 74w X 27~ Design Page.
Help HHLFE
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4 VA S 4.3 TH&E

e Contact Us, BtRFA;
Manage License, ¥ rJiF&HE;
® About, EFMALE .
E!
T E T2 )G, Project F&{ESE AP BN,

43 THE

F PR H DhRE MR VT M\ 1, AL A RO e S
2 T.#2 (New File or Project). #TH fFai T#2 (Open File or Project). fx
FF (Save). RAFFTA XXE (Save AlD. FTEI (Print). 44 (Undo).
#Eff (Redo). BIY) (Cut). Ei#l| (Copy). Hilli (Paste). & (Find).

4.4 TIEEHEKX (Design M)

T FR A TRE R AN SR8 BN R 7R T g, 32 B R /s B e CRE Pl
MBS S R B R R 2R DL B S 45

4.5 TIEEEX (Process BH)

FERMH T FPGA W itiisE, fHiZR4 (Synthsis). Afi JmfiZk (Place
& Route) LAK N#k b4 ot (Program Device), [l a] 33T T 44
FOFI IR LR T B3 AT 2 R S i

4.6 IR HamERX

SRR (130G 4 S R DI RE

1E File T FUBT BT IS0 286 J5 A2 B SO B & Place & Route
Je A R SO T BORTE SRR AR X, 4k “Start Page” K T2
“Design Summary” [FIFf 2 BIRE XA HE X .

WS R PE ORI R X N, FEAMBXT SCRFEAT T8 e fE, WIFESCAR
GiiEIX N3l “File Changed” XHiEHE, Wil 4-2 fi, %5 “Reload”
W) B HT NS A -

] 4-2 XU IR A E

Reload
] The file "C:\Usersiroot\Desktopil. 8IDEVtestVimplipnricst. cf£g” changed on disk. L__f_ii__J

# Do you want to reload?

Cancel

E

iy “File” SEHAE “Close” MLIE SCAS g 45 [X 24 AT o AT 44 4
) 3, 229 A SCA G 88 X P 24 T S s IR S0 A

sty “File” AR “Close All” HT, Il £ 5 SR i IX 4 B
BT S

4.7 EEHIHEX
BN BT AR ARG R, " FshYIHbr s T E A/ AN FI SR ) S
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4 IRPAT L S

4.7 5 Bt X

SUG100-1.5

HAE R

o £iff5E Ul (Output 71)
o {5 E U (Error 51)

o EA(ZHT (Warning 1)
o HAfEE UL (Info 51)

£ Output & i A8, % “Clear” , AIEZFTA TIKER, MAE
Error T1. Warning 71X Info U1 0 A7 5, Hdy Clear 3ET, HAgiE=
MHTTAIE S

BAT AR B Warning B0 Error £ 7EA < HIME B TR Ab e % H B
Warning 8¢ Error 1M 44,

7
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5.1 Hd TR

5 IR EER

ZUREATSZHF Windows Al Linux AN RAS, HL S35 5 AR 0N i 24T

HXJ&1T, LA Windows fiiAs, FEizirafl, S8t mse k.

51 @Iz

SUG100-1.5

TR FIOa 4T, WB% IR B Bl fr ST

VRS F 2K TR RTL LA Post-Synthesis T/,

RTL TR RTL WiltEARIN, PATEEE . MRk, NEEr
TSN TR

Post-Synthesis T-F2 W LA F 256 J5 B8 B R A % A\ ST, B 25 RTL
WITERE IR, BEEEPATA R & N8 R S AR
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5 IR

5.1 ¥ T

5.1.1 ¥13& RTL I8

1. i “File> New...” , #TH “New” XHiG#E, b 5-1 Froxso
& 5-1 g TR

SUG100-1.5

— W P
& New P s

4 Projects i

L. RTL Project

__:',@ Post-Synthesis Project

4 Files
E&. Verilog File
|5 VHDLFile
EE; Physical Constraints File -

Create a RTL project.
Tou will be able to add or create BIL sources, run synthesis,
place & route, and program wour device

| 0K || Cencal

2.

"

JRAE PR =805 AT “New” XFHGHE:

o fHJIIRIER Ctrl+N;

o i THFE “NewFile or Project” K¥x;

e i Start Page 71 I “Quick Start>New Project” .

W, WK 5-2 Fis.

& 5-2 $# RTL TEHS

. Wr New RTL Project Wizard

i%#E “RTL Project” , Hii “OK” , 4TJF “New RTL Project Wizard”

L X ¥

Project Hame
@ Project Hame

Select Device be stored The directory will be created if it doesn't exist.

Summary

Enter a name for your project, and specify a directory where the project will

Hame: tast]

Create in: C:%Usersroot'Desktophl. SIDE

DUse as default project location

3. QU TG, W 5-2 fix:

25(79)




5 = IR 5.1 Hd TR

e £ “Name” UAMEPHIANTRES
o ipif “l ) kTR,
vE!
o RAAT R AR AR MO SCRE B R A SO R AR, BT A LR ER AR ORI
A S
e  Windows Fl Linux RS AK A RG], {EBAE NS KB H 24t
FRAIITEOL T, MR B 5 DL AR AR 2 R
e 5 Linux AH, 7F Windows H 1241 BEAF N “\” , 1 E\Gowin\ide;
e /iikrh “Use as default project location” , BJ£xki% TR 1 B ONERIN KA,
N UCHT A TR BN TR QX842 .

4. Hii “Next” , % H FPGAGHMALS, WK 5-3 Fin.
® 1t “Select Device” &isH LS “Series” A “Device” ;
o {7 “Package” FHi%lRHEFEHFEIRM;
® 7t “Speed” THiFIFKH IEFEEEFEH;
e 7f “Part Number” # ik HFm A& M-S, JHFHZEFERIIERS T
FEAN BTG B
& 5-3 % & FPGA & H RS
rw New RTL Project Wizard - - ==
) Select Device -
e Sty e i £ o ot
o Series: [oM1E o) verice  [orit -
Package:  [FDGAZSG -]

Speed:  [CB/I5 -]

Part Number Device Package Speed \Voltage IO LuT FF
GWIN-UV4PG236C6/15 GWIN-4 PBGA256 C6/13 uv 207 4608 3456
D

5. i “Next” , 76 “Summary” Bk 5 @i FPGA T THS
B EEE, 1 54 Fis.
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& 54 THEER

r
i Mew RTL Project Wizard
W New roj izard a -

Summar y
Project Hame
Select Device Project .
Name: fpga_project_3
B Sunnary Directory: C:\Users\liyang@l\Documents\fpga_project_3
Source Directory: C:\Users\liyang@l\Documents\fpga_project_3\src
Implementation Directory: C:\Users\liyang@l\Documents\fpga_project_3iimpl

Device
Part Number: GWIN-LV4PG256C6/I3
Series: GWIN
Device: GWIN-4
Package: PEGA258
Speed: C&/I5

I

6. i “Finish” , THEAIE5ERK.
1
o UHMAESSHE TR FBM, HAMEEIES% 5.3 ik TFE>5.3.1 &2k
Tf& Device;
o TREFTEE HIUE SR M 2R S TR AR TREQNEE 2 S5, HEAIE B 155 % 5.3 nfE T
F>5.3.2 ik LA
5.1.2 ## Post-Synthesis T %
1. i “File> New...” , #TJF “New” XHiG#E, Wik 5-5 FiiR.
Bl 5-5 Fig TR

i @ EE |'1

w New

[ »

4 Projects
_:_af RTL Praoject

] Post-Synthesis Project 7

4 Files -
EE; Verilog File
[& VHDL File

EE; Physical Constraints File -

Create a Fost—Synthesis project.
If wou alreay have a sythesis—generated netlist file, wou can
directly add it inte project, and run place & route.

| 0K || Ceneal

!
JRATEE DA =877 A TIT “New” XHEAE:
o flJTPREEHE Crl+N;
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o T HEF L “New File or Project” E#s;
e Hii; Start Page %t - “Quick Start>New Project” .

2. %&# “Projects>Post-Synthesis Project” , Hi.idi “OK” , TJF “New
Post-Synthesis Project Wizard” & H, Wi 5-6 fis.

K 5-6 & Post-Synthesis T

+

Wy New Post-Synthesis Project Wizard - &J

Project Hame
IES.) Froject Hame
Enter a name for wour project, and specify a directory where the project will

Select Device be stored The directory will be created if it doesn’t exist,

Add Files

Summ ary

Hame: test_post]

Create in: C:WUsershroothDesktophl. SIDE E

I:‘ Use as default project location

B TR MR, WK 5-6 frs.

f£ “Name” SCAHEHHIA THES -

e L )7 IR TRRERAE

iy “Next” , %HE FPGA &R NAS, W 5-7 Fon. f£ “Select
Device” %i&Hi%E#E “Series” . “Device” .“Package”. “Speed” ,
RZAAE “Part Number” BEIAEEREZEAG AT, JF HAE Part Number
F2 2 TR A ots v PR B URAE B

>eo ow
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5 mIRHATAEH

SUG100-1.5

5.1 8T A%
2 =
& 5-7 {8 FPGA & HALS
rw MNew Post-Synthesis Project Wizard ﬂ‘
Select Device
Froject Name }
B Seleet Devics Sp;ir:]l-tf:'ra fempel doriee S poe grajest
hdd Files
Series: [N v| Deviee: [gH1N-4 -]
Summary
Fackage! |FEGAZSS -]
Spesd:  [CB/IS -]
Part Number Device Package Speed Vcltage
GWI1N-UVAPG256CE/I5 GWIN-4 PBGA256 C&/15 uv 4608 3456
4 n (2

5. Hii “Next” ,
2 E Ay SATN
!

7% “Copy to project directory”
5-8 ¥ LR

vm . .vo . .SV . .vma. .vimd.

7E “Add Files” F#&HhikBEM R (Netlist File, J&5

vp), i 5-8 Fi.

o TUPRF ISR SCAE R A B TREPTAE H 3%

s - -
A New Post-Synthesis Project Wicad T

=)

Add Files

Froject Hame

Specify a netlist file.
Select Device

E» Add Files

Summary

Hetlist

C:fUzers/root/Tesktop/l. SIDE / more. vm

Copy to project directory

Erowse. ..

[ <Back || Fext> |

5

6. $$ “Next” ,

£ “Summary” &R AZREETE K FPGA T2 TR

B SR E R LSS E, WK 5-9 Fis. on 1 #T i Post-Synthesis
TR TEER. SHERLIECHEER, T8 B TR E

it o
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5 = IR 52 {1 TH#E

& 5-9 i TEREL

5
v New Post-Synthesis Project Wizard @

Summar y
Froject Hame
Project
Name: impl_project_1
Add Files Directory: C:\Users\liyang@l\Documents\impl_project_1
ﬁb Funmary Source Diregtoryi C:\Users\liyangal\pocuments\impl_projEct_l\sfc .
Implementation Directory: C:\Users\liyang®l\Documents\impl_project_1%impl

Select Device

Device
Part Number: GWIN-LVAPG256CE/IS
Series: GWIN
Device: GWIN-4
Package: PBGA256
Speed: CB/IS

Metlist File
E:/work/1.8IDE/clk.vm

7. Ei “Finish” , THEAIE 5.
!

o GRS SENELEAWE Y FIEM, FAERIESH 5.3 fiE LFE>5.3.1 1B
T.#% Device;
o  TFEFTTR MR SO R AW TR LIERN B 2 G, vE4E BiE5% 5.3 i 1

F#>5.3.2 gt TAE A
52T IR
F Pl Bl IR ST I S0 i 3 R, A LR PO AR
J7 AT TR
HiE—
1. REspidr, k¥ “File> Open ...” 17 “Open File” XJiEHE, 41/ 5-10
Fiwe
!
IR e TRAE By« 7 BlFR, #THF “Open File” XTiFHHE.
2. i&#E “Open File > THEXH (*.gprp) 7, Hifi “Open” , TH Ti%E.
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5.2 {TJF %

SUG100-1.5

A 5-10 fTH LR

WAr Open File

&)=l LEDE b et

EA~ it

1

& TE configure

W =E impl

E SRR sre

|| test.gprj

=1 || test.gprj.user

B w3

= BA

B 3o

& =5

M
& s )
o TR (D)
oo TS (E) -

EEN): testgpri

GPRJ 3%
USER 324

= O @

1KB
2 KB

- [Alfles 0 -

P

1. fF “Start Page” T, By “mmn ”

1,

2. %&F “Open Project LR (xgprjp) 7, Hii
3. “Open” , fTH I,

TE=

, T+ “Open Project” Xt

Sefed, i “File> Recent Projects” , &£ 4T P THL.

E!

e JRT{E “Start Page >Recent Projects” &, & FHITIH TR,

e  “Recent Projects” NITFT L i LRESIR

o AL TRCWIME, &3 “Open Project” #2754, & 5-11 Fiaw.

& 5-11 TREMBRRSAE

) Open Project

I-"_"\. Can not open project "C:

apr L

X

X _,-'I “WWUsers\nerissa\Desktop' 1308 T\GW_MIPI_DPHY_RXTX_RefDsign\GW_MIPI_DPHY_RXTX_RefDsign'project\Example_Design'Example_Design.gprj"
The system cannot find the path specified.

FEARIFR R 1 TRE, £ TR A TR F.gprj, My TRESCHF

e AN IR BAHT T TR
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5.3 YmiE L 1=
BT LR G, AIE LA HE XX FPGA LIS HE B LML

34T dm A, Wl 5-12 FTaR.

THEEEX FTEAEITIER:
1. FPGA LFEMKAEE S,
2. HFHIOHER: SRS, B350,
3. Ml LAEASHXHER, BIEH 3. WEA R Cest).

B P2 RS0 (sde). GAO BLE S (.gao). ThFEHr GPA BB A+

(.gpa) %.
B 5-12 TRXHED

Dezign B X

4 fpga_project_1 - [C:'Wsershlivang0lDecumentst fp
[©] GWIN-LV4LQ144C5/14

4 Verilog Files
counterv

a Timing Constraints
fpga_project_l.sdc

4 Physical Constraints
fpga_project_l.cst

4 GPA Config Files
test.gpa

4 GAD Config Files
fpga_project_l.gac

5.3.1 ¥ T2 Device

FE TR PRIX EE —AT WA e BAR SR 21T FPGA TR T HI RS 15
E

PIARS

1. wnE 5-12, Wi “GWIN-LVALQ144C5/14” , #TH “Select Device”
wWH, W 5-13 Fik;

2. £ “Select Device” & M Wik “Series” f1 “Device”, f£ “Package”
TR R PR EBERM, £ “Speed” FHA|RPIEFHE T LS, £

“Port Number” # &R HARRIS, BIn &S 57 TAERT H 1 Device

BFE.
!
“Port Number” #2278 Firide o 7 (1) FEAH 22 IS 8
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K 5-13 TR E Device 8 2

-
W Select Device

Filter

Series: [GHIN

v Device: [hny

Package: [Any

Speed: [Any -]
Part Mumber Device Package Speed  \Voltage 10 LuT FF o
GWIN-LV4LO144C6/15 GWIN-4 LQFP144 Ce/15 v 119 4608 3456
GWIN-LV4LQ144C5/14 GWIN-4 LOFP144 C5/14 v 119 4608 3456
GWIN-LV4MG160Ce/15 GWIN-4 MBGALB0 Ce/15 v 131 4608 3456
GWIN-LV4MG160C5/14 GWIN-4 MBGALG0 C5/14 4608 3456 U

--ml

GWIN-LV4PG256C5/14 GWIN-4 PBGA236 C5/14 v 4608 3456
GWIN-LV4PG256MCE/15 GWIN-4 PBGA256M Ce/15 v 207 4608 3456
GWIN-LV4PG256MC5/14 GWIN-4 PBGA256M C5/14 v 207 4608 3456
GWIN-UVAQN32C6/15 GWIN-4 QFN32 Ce/15 uv 24 4608 3456
GWIN-UVAQN32C5/14 GWIN-4 QFN32 C5/14 uv 24 4608 3456 _
4 [ | +
Cance

5.3.2 B T IE

RTL LRGSR ASE M P RTL Wit 3CfF (Source Files).
LIRS E SO o, AR aFE B R S (Physical
Constraints File). B JFZ)# 3 f (Timing Constraints File), & /455
GAO & i/ (GAO Config File). GPA Bl E X (GPA Config File).

RTL TAREAI & 2 AP ik S, BT s — M B L A —

AN P A RS o

Post-Synthesis TFEfE@ LR C&din 7 P MRS, Bk T
EEE YAl = PR S0y ) D NA EAVZ S 7 1YL= 1 o

CARTL AREABI, S48 an ] 2 B R P =5 XA

1. Fr TR

2. WK 5-14 fios, £ TR HE X 2 (A AL s bR oA 18, 18 9% “New File...”
FIIFH SO New SHEHE, Gl 5-15 Frwo

3. TEE5-15 1, EHFFHEA SR,

SUG100-1.5
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SUG100-1.5

Kl 5-14 F4ESE A

|  FEle Edit Project Tools Window Help

De=ign 5 X

T " 1) |_TI_-:__ } u-:.-!
DEHE =ie s 000 #<

4 “ fpga _project_3 - [C:I'LUEEI'E"Lli}'SILgDI"I.DIZIL"L'I.mEl'I.tEI'I.fP'"é

GWIN-LVAPG256C6/15

' New File...
[;E‘ Add Files...

Display 3

. Configuration

Proces=s
5-15 FrEESCpEFHE

W New ?

*

[, VHDLFile

- E;. Physical Constraints File
— |_—£} Timing Constraints File
— & GAO Config File

——— [, GPA Config File

- . L;} Memeory Initialization File

~ Files
B verilog File

Create a Verilog HOL file.

AR

=

FH 7 Verilog ¥eit S
VIR L R SCAF

GAO fic & s
PRI LR S

QO®O

FH ' VHDL ¥t 304
I 7> 240 SR S A

GPA fic & 34

® CIFRAEREX

@EE®
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4. 1Nl 5-16 i, LLETEE Verilog File N, kb “Verilog File” #7137
7 Verilog File & I,

K 5-16 Fr#E Verilog File FH1H

F

Wy New Verilog file

Hame: tast
Create in: C:h\UzerziroothDesktopil. SIDE M testhzre

#dd to current project

5. HEM4, HBiEF “OK”,
!
o WEEMY M, BRINAE “Add to current project”.
o WTEESCHFSRIR IXFT R S A A, SRRV R T S

6. HrERCE ST

a) Wik 5-14 For, £ LREEHX T AR ERAAAE, EF “New
File...” , TIP3 New #HGHE, W1l 5-15 fiw;

b) £ 5-15 H, IEFEFHEHEMACE SR, BUET E GPA Config File
i, iEH “GPA Config File” T8 GPA Config File & 1,
5-17 fli7R;

C) BrEEWCE U, A EEAEIR SO Yn i X FT R i A A B S,
A LA B X W FL & S, DA T 2 AR E S, AT
Yuld, Wl 5-18 AR

& 5-17 g Ae B SO A E
rv} New GPA Config File l PR )
Hame: test|
Create in: C:\Usersiroot‘Documentshfpga_project_18%sre Browse. ..
0k | [ Concel |
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A 5-18 B B SC

General Sstting | Rate Setting | Cleck Setting

Device
Device: GH1H-LVIEGZSECE/IS

COMMERCTAL +

Operating Condition: Brocess:

Enviromment
Ambient Temperature: 25.000°C 2| (~40'C-100°C)

[ Custom Theta JA: |25 0007/ |

Custom Theta SA: 25 000°C/% |2

Board Thermal Model
@ Hone Custom
Board Temperature: |25.0007 | Fan‘C-1007C)

Custom Theta JE© |25 000°C/H |

Voltage
VOO 1.200% |5 (L. 14V-1, 28V)

VCCH: 3.300% 5 (2. 37T5V-2. 725V or 3. 135V-3. 465V)

TYFICAL -

Heat Sink
@ Fone () Low Profile () Medium Profile () High Profile
- e

Typi cal

() Custom

| J i | B

Design Sunmary

W GPA Config View

B |

!

) tiuﬂﬂ)ﬂiﬁiﬂu HJ Verilog File 5 8B W CFE 4, WIEERM, FFedstnr, Wk 5-19 fr

N3

o HIRIIIIL R SCAHE TR B4 07 1E, M/Ai% “Add to current project” , 4t
it 5-20 FR, $RAREIERINE TR, (HR ISR IR X 3T I3 s (13

. INAAE “Add to current project” , ML R,

QST ARG B SR TRESCIF o D Ar e, PR BiRan, i 5-21 for.

[ )
5-19 ELZ N

-

W New Verilog file

Hame: tect

Create in:

#dd to current project

File test. v already exists.

C:WUzers'woot\Desktop'il. SIDENtesthsre

Erowse. ..

il

===
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A 5-20 TRRAFRSCHME—H

(A GOWIN FPGA Designer - [Design Summary]

| Ele Edit Project Tools Window Help

Design 8 x
a test - [C\Users\root\Desktop\1.8IDE\test\test.gpr]]
GW1N-4-PBGA236-6

4 Verilog Files

testw
4 | GPA Config Files
test.gpa

a Physical Constraints

test.est

| Design [Frocess |

Project File: il

Target Device: GW

Device Part: GW
Start Page

Output

Can not add file C:/Users/root/Desktop/l.8IDE/test/src/testl.csc, alreay

include same type file.

A 5-21 Bt B SCHFE—

Wy New GAQ Config File

Hame: test

Create in: C:'UsershroothDesktophl SIDE‘testhsre

File C:/Users/root/Desktop,/l. 8IDE test/sroftest. gao already exists. 0K l [ Cancel ]

Browse. ..

7. IR

el 5-22 flos, ETREHEXZ AL, fliblirfa, % “Add

Files...” , FT7F “Select Files” fiHHE;

8. EFFLAEIMF, WFI S LA BRSO, S GANInE F

T
!

o UNINSCARRY, k¥ “Add Files...” , WSREINAISCAE AR TR B SCIF 2 BEAT 1R
AT BRSO R I B TR H %, T CRRAR, Wk 5-23 fr;
o INFEIMAIN RTL SCHE L0ROCHRSE, Btk & B ah e TR SO B X SCAFREAT 70

x;

o WL PASEEAL L “Project> Add Files...” ¥ LFESCHES
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& 5-22 Design & 0 A%SE#

W GOWIN FPGA Designer - [Design Summary]
| Ele Edit Project Tools Window Help

Desi1zn B X
4 fpza_project_1 - [C:\Uzershliyang0l‘Documents'£fp---
GWIN-LVALQ144C5/14
4 Verilog Files
Mew File... I
counterv
4 Timing Constrai = Rl e
fpga_projec Display 3
4 Physical Constr: .
. o Configuration
fpga_projeci

4 GPA Config Files
test.gpa

4 GAD Config Files
fpga_project_l.gac

5-23 CHEH B TRBRERTE
[ Add files B |

& D These files are out of this project’s source directory.
" Do wou want to copyv them inte the source directory?

Erworkifloorplanneritop3.wm

%

9. fEMCTREMF
el 5-24 fiow, AE LU R 2T S0

a) Wiy TREE X A ISR, 7 9 B SO B2 SR AR RSO
BEIX 5
b) A EEL S, Hidr “Open” o
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&l 5-24 TR SCH4REEEHA
W GOWIN FPGA Designer - [Design Summary]
| Ele Edit Project Tools Window Help
Desi1zn B X
4 fpza_project_1 - [C:\Uzershliyang0l‘Documents'£fp---
GWIN-LVALQ144C5/14
4 Verilog Files
= cour
— - N D FIEFI -
4 Tirming .
Open With...
fpge
4 Physical Open Containing Folder
fpge Open Terminal Here
“ GPA Co |2 Remove.. Del
test,
r GAD Cg =) MNew F”E...
fpga d Add Files...
Display
- Configuration
!
e ik# “Open With>Add External Editor” , ¥R INakE &AM IC M2 5 10, &
5-25 Frax, L RIARYE B B 4 A ) S I A g R 4
e P “Open Containing Folder” R F] JF 3044 B 1 A 3
e EF “Open Terminal Here” RI4THfrATi247 % 1, P nl@ddr 24780817
o AR g A T AE VR S T T SCIHME BUR IR 2 5, Gowin =
PR A2 TR S IE A, iR 5-26 PR
o PR EARIRAEII A, SRS TR SO ORAF @ S0, &l 5-27 s
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A 5-25 SR gmiE A%

W7 Options X

External Editor

& External Editor
%, Environment
== T Editor Name Program Arguments Add
| nodePad+~ C:/Windows/notepad.exe %f Remove
’ External Editor
(_:) Synthesis
[*litems request restart GOWIN FPGA Designer Cancel Apply

A 5-26 TRESCHZAE B &

Reload
] The file "C:WWsersiroot\Desktopil 8IDE\testisrcitest. ¥’ changed on disk. ki

H '-I Do you want to reload?

Cancel

&l 5-27 TSR

Wy Save

:

Save changes to "C\Users\root\Desktop' 1L.BIDE\test\src\test" ?

1N

| oK || Discard || Cancel

10. MlFR TRE A
a) e TR X N A SO
b) Hidi WA, %% “Remove” ok E kA “Delete” #, 7
“Delete File” XFiHHE, 411& 5-28 fin . #5111 “Delete Permanently”
STEAE, MNZSCAE NS HT TAEMIBE BAEREEE EMIBR, B0, %S0
M4 R T LR
5-28 LA ER TN
[ Delete Files 2 [ |

Do wou want to remowe these files:

Diuser-bak\Users\root\Desktop\1.8. 1IDE\IDEOT06\src\IDEO706.cst

L
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GO B 2 R AL TR X R SCE, B s SO s S, an ] 5-29 BT
F 5-29 SCAAHH R E 50

K It
' The file "C:\UsersirootiDesktopil 8IDE\testisrcitest. v has been removed on disk.
G Do you still want to keep 1t?

533 B TIEhE
1. ETHEREX, o bnas;
2. 1&#% “Configuration” B #.4= % Project->Configuration.., 7 JF T
e B JE ML, & 5-30 s

& 5-30 TfEACE Wi
r\,\'; Configuration ? ﬁ1
Synthesiz | Place & Route | Dual-Purpose Pin | BitStream |
Lai)e\ Value i

m

Top Module/Entity

Include Path

Frequency Auto
Use Clock Period for Unconstrainted 10 False
Fanout Guide 10000
Disable IJO Insertion False
Update Compile Point Timing Data False

o (Omea [ oty ]

WK 5-30 fin, AIECE M AR % & Synthesis J& 1. Place&Route
J&YE. Dual-Purpose Pin J& 4L & Bitstream J& -

® Synthesis: M Tt &4 T HAMALE P& itHi BT S EUE
® Place&Route: HTHEIE1T40 AL IS HUE S,

® Dual-Purpose Pin: I T-lit & Jiri Device {5 5 Hh 277 200 B 110
SR, FEATREEHER;

® Bitstream: F T-HECE =419 bitstream X275 0 CRC K. &
B4 DL N AR I E
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HRAE SN LIEBEMNEW T,
1. Synthesis
o T FEfCE Him, i%&#% Synthesis JETETT, 7E “Category” FHi%l|F ik
BSHECEIET 2, BN “ALL” ;
e f{tf “Lable” F|FEHIEHEFEEMSEH LR, “Configuration” & 1B
L EINATZNEA RS
o NHHTLRLE S “Value” {H, RIEFHFKREE, B “Apply” , A
fEMATRCE AR, FrTdkaicE; Hidr “OK” , TERITAIE.
o JI!
o XTHHSHEMBIXRI LS X, ES%H M3 A SynplifyPro &% &K I57R;
o ST HTHRLE M, BAATT S 2R 235 H 3N Synplifypro #H5¢ 304,
%1% installPath\SynplifyPro\doc;
e  Post-Synthesis T H T CALZEE, WA R Synthesis LT ;
e Resetall to default: /i it & 7T A Z BN E , 5559 ) Reset $&7RAE,
& 5-31 s
5-31 Reset 3£~ 1E

W Reset ||

Are you sure to reset all options to default?

| ok || cancel |

2. Place & Route

Place & Route It & /& & = M7 B EHEAR BT G 2 U5 ) Ja P4 e L 7
H, W Value iz im i, AiEits (i 5-32 fror.
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A 5-32 iL B i A2k B i

ap Eun_ﬁg.ura'liun | ]
I Synabaziz | Flace & Boute | Bual=Purpess Fin | BitStrass
Catagory: |ALL - _hlﬂ. all Le hft.ull..
. Label Value
[f:ljn—-—- Generate SDF File Falzs
(@: s Genarate Constraint Fle of Ports False
{E} Ll J Generate IBIS File False
:'a_:; -_ 1 Generate Post-Place File Truwe
e IiS: H—= Generate Post-PMR Simulation Model Fle True
FE\' _ H— s Initialize Primitives False
- \_?)- et Shuza All Warnings False
(8;‘.‘-—-—* Generate Plain Text Timing Report Fa'se
B |/_\|7_JRUH Timing Driven True
E} — —— Use SCF False
':'l_j,l H—— Mot place register to 108 False
@1
| ) Cewe) nr )
@ PAEMFE SDF X @ 7 Port LIRS
@ 724 IBIS X fF @ PR A R S
® PSRRI ® S0 EARL S A
a T PT A BRI AR E
@ i pra f Warning 552 ® FEEEIZIK?%fCE’JHTF”T&
(© iZ4T Timing Driven 12 (0 ﬁ}fﬁ SCF xff:
@ THEBENFERA @ BUHEARX
H210B L
3!

Reset all to default: 47 Ac & 51 4= K RN B HE -
3. Dual-Purpose Pin

Dual-Purpose Pin B E &1 &z g fil S E I E, BAARE
i H & 5-33 Pk
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& 5-33 MBS AEHE
r“} Configuration [ D e |

| Synthesis I Flace & Route | Ial-Purpose Fin EitStream |

[] e TTAG as regular IO
[] rse SSFT as regular I0
[] rse MSFT as regular I0
D Use EEADY as regular I0
D Uze DOWE as regular IO
[] Fse EECONFIG_H as rezular IO
[] Use MODE as regular IO

0K ] [ Cancel ] [ Apply

E!

SHE M E MR E T JTAG M1 JTAGSELN A HFx &, B4 ARAE JITAG &1
N, BRIAIESE ITAGSELN &, 421k JTAG &I, NIERIAAEEE ITAGSELN &
o

4. BitStream

BitStream It & /& & o0 i N 1 bitstream SCA# A BLL R #;
PR, HARHCE S Xk 5-34 Fios.
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& 5-34 Bt B HASR A B

[ o : . T ——
e Configuration l 7 “J

| Synthesis | Flace & HRoute I Iual-Furpose Fin

[7] Enatle CEC Check
D Enable Compress
':‘ Enable Encryption (only support GHEA)

nable Security Hit
[7] Enatle 5 ity Bi
[7] Print BSEAM Initial ¥alue

!:I Background Frogramming

SlIe

EitStream

Fey (Hex): 00000000 —-0o0anaan —-0aonanann —nannon

SECRCRC

Download Speed MHz): |2.500 (default)

| SPI Flash Address:

@ o OOFFFOO0
USEREIZI]ZIE: @ Default ) Custon |000000OD
@ ‘ Bitstream Format: @ Text () Binary
[ 0K J [ Cancel ] [ Apply
@O CRC &ALk Q@ Egiflike
R mEMiEe (R ew2A) @ HEE XY
G w4afiflife (® ¥ BSRAM¥JA{H
5 N bitstream
s
@ A% TH%
(@ SPI Flash Hifik i P 52 X User

S)

EUARFIRL SO A% K
!

Code

SPI Flash itk F5 & —% multiboot i}, Jn#k bitstream SCAF &G HibE, BT S5

Gowin Programmer /4 /75

54 =TS

ERREHX, JIH T Rn RS RRE #P R, ik 5-35 fs.

FEAZ T VAT AT DL 434
® % Design #ik;
® )% FloorPlanner;
® 5 BN P R G A
® HATLAEIIRE:

SUG100-1.5
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BE LA ROHR T
AT AT R A 2k
1% Place&Route J& 14 ik 2 ;
® JGzhE 31k FPGA FifE#e 5 Thae.
B 5-35 RTL L#& Process & 1

Process f X

| | Design Summary
b _; User Constraints
i FloorPlanner
“* Timing Constraints Editor
v () Synthesize (Synplify Pro)
Synthesis Report
Metlist File
hd x_,-' Place & Route
Place & Route Report
Tiring Analysis Report
Ports & Pins Report
Power Analysis Report

u .
41 Program Device

E!
Post-synthesis T2 i1 T ¥ it Xt B &4: 4, #A SR Synthesize (Synplify Pro) 377,
5.4.1 Design Summary
BrE RTL AR, A2t TGRS A5 B IRt — ik s,
Kl 5-36 fii~, A —=FJ5iEFTFF Design Summary:
e {f GOWIN FPGA Designer 3.4~ |, &+ “Window> Design
Summary” ;
e 1f Process @&, Wi “Design Summary” ;

® {i Process fit&H, HiiArfitE, 7& “Design Summary” HiE#E
({Run” R
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& 5-36 TREfE B R
Project File: Ci\Users\liyvang01\Documents\fpga_project_1\fpga_project_L.gprj
Target Device: GWIN-LV4LQ144C5/14 Device Series: GWI1N
Device Part: GWI1N-4 Package Type: LQFP144
Core Voltage: LV Speed Grade: C5/14

5.4.2 User Constraints
User Constraints $&4t 1 PRIEFT H A QIR LRSI 1. A R Y
W|AWVEMME T, 1625 % Gowin &/ 20K TEH

User Constraint 434 FloorPlanner 1 Timing Constriaints Editor.

Y FE ) R i 4 28 FloorPlanner {i FH 25 3%

1. Md“FloorPlanner’sifE 47 S ik #% “Run”, A5k E3h
Synthesis XU REATER G, BN ST YL R i 25

2. TP R gmigan, & TEPASWEA R Cest), i
2 FLRES 2 A SO DA 2 4 5

3. fIHgmiEAE, WRTEPASPMEA AR Cest) KAE T,
FEVE A g X AT T2 /475 , /it FloorPlanner H1 (] reload

S BT 2 SO T AT

4. FTRRPARAA MO, HIESCFiE B FitE 5 TRA
LIRS, GABINE, BT eI @ o r@ s,
5-37 T

5. 5 LA PR A LR SO, (RIE ST F 3% R AR S TR R 44 10 40 3RS
T Cost SOfE) B, BB EE B TG A5 TR
Ly, AR EE TN Warning $2~4E, W 5-37.

byl

R PR “Tools” 2L “Floor Planner” A1 “Timing Constriaints Editor” , 7] B4
Floor Planner FIli P21 sk gndE g, 110 ANEAT BT SO 255 34 -

5-37 BB LR

ww Constraint File S

This project doesn't include CST file(*.cst), do you want to create a default
one?

Ok ] ’ Cancel ]
5-38 B L FRCMF Warning #7
w Warning o E5 |

There is already a default CST file: "[nfuser-

e I b bal/Users/root/Desktop,/1.8. 1IDE/IDEDT06/src/IDEQNTO6.cst”, do you want
to override it?

OK ] ’ Cancel
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T2 53R 4miE 8% Timing Constraints Editor 574!

1. XiH“Timing Constraints Editor”s(7E 47 S 2 B IE S “Run” , BAF5t)E3)
Synthesis XS HATER G, IR 4T TFIN T IR B 45

2. TR gwiEARRT, # TREPESH TR (sdo) , amIhE, WEHRaE
P B L RSO DA

3. B LR ACEMPA A S, HIESCHATE 3 T A S TR 4 28
fF, B s G QRO R IE AT, & 5-39 R

4. FHTREPACELRM:, EIFEXIF ER RS TRERARA RS (sde X
) B, ZRE RN, S IRBERSCEH  N A — A5 LR R A AR S,
5 EE % E /) Warning $2RHE, & 5-37.
& 5-39 B PP 29 3R SO

W Constraint File S

This project doesn't include SDC file(*.sdc), do you want to create a
default one?

oK || cancel |

B 5-40 BIER LRI Warning 371
W Warning L X
There is already a default SDC file: "D:fuser-

l 5 bak/Users/root/Desktop/L.8.11DE/IDEDT06/src/IDEDT706.5dc”, do you

want to override it?

OK ] [ Cancel

5.4.3 Synthesize (Synplify Pro)

Synthesize (Synplify Pro) & Synopsys A &) & = 2 AR 7] & il AT
LR A A, SCRER - AR RSO LS, CFF VHDL. Verilog %54

Synthesize (Synplify Pro) #24it /1217 Synplify Pro. & & Synplify Pro
SR E B R SO (Netlist File) F1ZE &3 2 (Synthesis Report) FITHAE

%% L N5 i 4T Synthesize(Synplify Pro):

i & Synthesis J& -

£ 2% Synthesis B L E, 2% 5.3.3 BN LERE;

1217 Synthesize(Synplify Pro);

B HIX, Widi“Synthesize(Synplify Pro)” s 45 f .5k
“Synthesize(Synplify Pro)> Run”, J&ah4ia T A E T4
LA T, W Synthesize (Synplify Pro) £2RT<x i ILES: ¥, &)
HILE R @

5. ZEAMINE, Wi “Netlist File” B(EZIUA#IER Run LT, W&E
WA, HA R MRS A RS TR AR .

hwpdPE
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o uiAZ AT (Synthesize (Synplify Pro), EirA =) X “Netlist File” si7E
ISR Run BT, W 2eii 747G, SR8 N E FT TR ST A: .

o FiFA I Synthesis Elbr i =k “Synthesis Report” B{{E %A k3%
Run &I, MI&kdtirssty, oMo Faamd.

g “Synthesize (Synplify Pro)”, A #ETIHERERL &

® Run: 17 Synthesize (Synplify Pro) £ i Btz R = . @ ¢ i,
IRPZE T2 A S oA L BRSO T 456

® Rerun: it Synthesize (Synplify Pro) I FUIRAS, MEFEIZIEIN,
R G LRSS AT 555

® RerunAll: Jit Synthesize (Synplify Pro) 2l FiRAs, HEFRiZik
T, HH A gk E T RIS T 45 6

® Stop: ZiGdfEt, AEERIZED, &9l Confirm XFIGHE, &
£ OK B A5 1k 2R A I F2

® Clean: ER4EE a4 xF% (synthesize) T HIFTE U K At
Je, ERZIE T, #0 4 Confirm XHHE, 0l 5-41 Fow, iEFF “Yes”

BINTERR:
® Configuration: A%} Synthesis S ¥HT K & .
5-41 {5 FR A 2 BN EIRN
&y Confirm |

All file and directory under path
"CifUsersfroot/Documents /fpga_project_12/impl/synthesize” will be
removed, do you want to continue?

Yes ] l Cancel

5.4.4 Place & Route

SUG100-1.5

Place & Route &L 1T /A Lk 1B B AT /A LS B & PRAT /A 2
Ja AR I T RE
!
Place & Route {&#i T- 45 & #2, $ATiZL A, WHAKHII (Synthesize (Synplify Pro))
KPAT, ML5EHAT Synthesize (Synplify Pro), FHUTIZETE.
BEPITHBIEIT Place & Route:

1. B & Place & Route &1

*F Place & Route JEMALE, 5% 5.3.3 B LIEACHE ;

iz47 Place & Route:

X it“Place&Route” B¢ H.fi i Ar 4 “Place&Route>Run” 474 &
A=A bit RSO e 5 S0 . is T ), N Place & Route

hown
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2 LR bR, S0 L @
5. Place & Route iZ47 )5, 7 Place & Route | /7 XWili SO B4 %k ¢
“Run” A AE A G 0 DX 00 b A iy S A
6. FEALERKIUM I, A Place & Route Report. Timing Analysis
Report. Ports & Pins Report /% Power Analysis Report, X JYff 3 {F:1)
ANFT G
!
o FUETEAII R U, FHIZAT Place & Route F AR Ik 5 UG SRR TS
SR
e 77i&fT Place & Route Z fif (Place & Route #f7EIbsN = ), Xl e sifE
RS SO A BEERE “Run” &0, J<x%6ia1T Place & Route, ia47 i a1 7T
i At

Fi it Place & Route, Al i#H4T HE/EE 5.

® Run: [ Place & Route 2 Ikt ot @, seirizimisiz
1T Place & Route;

® Rerun: it Place & Route 2 Fuik#s, @EHFZED, HEH ST
Place & Route;

® RerunAll: it Place & Route & FeiRAS, RPZET, FHisE
&, LRAIIE, FIE1T Place & Route;

® Stop: /S, FHEEPZIET, S#H “Confirm” XHEHE,
HEE “OK” Hia{E1kia4T Place & Route;

® Clean: j#HF&IZ4T Place & Route Jo =430t (pnr) FHIFTA X
R SC e, RFRZIET, S Confirm XHGHE, MFTRIES Yes
M 275 B

® Configuration: 7%} Place & Route Z¥i17 1% & .

5.4.5 Program Device

SUG100-1.5

DIRHAREAT WA LIS T G, AR (s XX, A
N2 Sk FPGA SiEEE, A T LR S fE FAREAS ) SCHLE P BT
T RE -

E!
Program Device #§i T- Synthesize /% Place & Route 38, HUATIZHTRIN, a0 HAKH#I5
(Synthesize /& Place & Route) AR#AT, WoxfeP AT HARMIT, HHATZEIR,

® X “Program Device” ERfEZIA ST “Run” &1, T &=
TK FPGA %ifids, K&l 5-42 fis.

o 1iHEHd: “Program Device”, %+ “Rerun All”, HEHig T a2,
fi$5 Synthesize. Place & Route & Program Device.

!

Linux 22340 b ) 4 A2 #53% T Linux iA Red Hat 5.10, W17 Red Hat 6/7 iAS 4 FE %,

HREMN ETHZREE, BB #h Gowin =i 22300 b i) sk

“Programmer”
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K 5-42 Programmer 518

i Programmer 2

File Edit About

a5 —

Enable Family Device Operation File Checksum  User Code

1 GWIN GWIN-4 SRAM Program €:/Users/root/Documents/fpga_project 12/... AESL 0DODAES1

fAxRKE -3k FPGA HRES: WV EAE RIS, 625 _(Z0 P #as/l
ST

5.5 IR

LT 7GR H IDE:

1. iy “File > Exit” &0,

2. BB EA EAERE RS,

!

o HARMRIFMSTM, W Peferm &G0 ST AT R AT

e IDE #2ftH#1E (Save). 1#1EFTH (Save Al FIH 1N (Save As...) Thig R
BE X SUA G AR BNV AR AT 5

e IDE X T AL E (Configuration) {5 2 & L E %t THE SO B3G5 e E AN 2
RIS ORA7 B TAERC B S, 78 IDE X HIR B3R AF
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6%}%7&1#%5&21&

6.1 Synplify Pro

Synplify Pro /2 Synopsys 2 i Jaifi 2 S % 115 BRI £ 4 A
SRR PSR LS, S0F VHDL. Verilog 5421 .

%F Synplify Pro [V E401E 5 M E1E 15 5% Synplify Pro 44 5“Help
PP Z T HI N RS

6.2 FloorPlanner

Gowin Floor Planner & &z - SR 7 T 3 5 £ R AR R S EE 2
Wi TH, SZFE% 110 Primitive (JiiE ). block (f7f##5H. DSP). Group
SR BN A A B AT B SAE e Thae, R Rl AR SR A P G B A R I A
REARH, e T 110 FEHEE, FiE. BRI EE B,
Gowin Floor Planner $24it 1 & B AT /i 5 2 W dm i ThRe, vl SR =2k
SRR &K FPGA 85 7%

J& 7)) FloorPlanner P #7520
1. KRB FGPA LFERT, A EHIZEHMSE AN “Tools” Fhidk dik#

“FloorPlanner” , i, FEiEid File>new HNEE M F F L) o S0 K T 7

R R
2. 57 FPGA LfEH, HEFEAMFEEFHX NS “FloorPlanner” , i,

Floorplanner <> E# &L TH# S 4FFF 7R 7E Floorplanner 5[ .

FloorPlanner 43/ ChipArray 1 PackageView PN 1, 40

K 6-1 F1P 6-2 Firas, & LA H 755 %  (Gowin #7120
7557 ). BEIt2 4k FloorPlanner & 1] LLEAT B EALAL -
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6.2FloorPlanner

SUG100-1.5

& 6-1 Chip Array B0

7 FloorPlanner

File Tools View Help

# Inte LEAULLE § Parzing netlizt file

* 0 fUsersfliyangdl/Docoment s/ fpga_project_1/inpl/synthesize/rev_1/ fpga_project L wn’ conpletsd

> Infe  (PADODB) © Processing metlist conpleted

> Infe  (MEOODS) © resding eomstraint "C:fUsers/liyangdl/Decunents/fpga_project_1fsre/fpga project_L, ost”
> Info  (CTOODZ) © Physical Constraint parsed completed

e [ T/0 C | Primitive G

DEAE@ <
Lizt 8 X || Chip drray [ ‘ Package View
4 0 counter
> L Ports (10)
> | Primitives (16)
[ Nets (28)
> I Module
» | Timing Paths
Mezzage g X

Group O | Resowrce R+ | Clock = | Guadrant C | Helk G | Vref C-

Ready

6-2 Package View & [

i FloorPlanner

Ele Tools View Help
DEHE®@ @
List & X | Chip Array Package View [ |
Project | Netlist
a [ counter _ ’ - i
[ Ports (10) 200000000000 EC
[ Primitives (16) - o 200000 o
[ Nets (28) — -
| Module 2 Q9 @ =
[ Timing Paths 9 QG .
® D ¢ SEIG
B € 90 e
1 £ D 2 &5
POOGG I
POGEG SEIE E
200 0e6 POOD O B
2ee 200008 B
B O C BOOOOC 3
Xt N &
R D 3 200006 B - @ -
PO 0C
8 0 6
Meszagze g x
7 Intao LFALIOOE T Farzing netli=t fa1le P
0 Alsers/iyangll focunent s/ fpga_project_1finpl/synthesizefrev |/ fpga project_1 wn’ conpleted
> Info  (FADODB) © Frocessing netlist completed.
> Info  MEOODS) @ reading constraint "CifVsers/livane0l/Docunents/fpea project Lfsroffpga project 1 cat”
> Info  (CTOD0Z) © Fhysical Comstraint parsed complatzd. i
Merr | T/0 = | Erimitive = | Growp O | Resowee =+ | Clock= | Guadrant = | Helk O | vref o
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6.3 RF)R4w3Ees (Timing Constraints Editor)

EaNFL R AR (Timing Constraints Editor) J2& &z 2 SR 5] 1
W ERER I P R g TR, SO 2RI P 20 A & 1, ELFE I b
2R N LR B L AN B 15 S5 4 4R 4 . Timing Constraints
Editor 2t 1 &l S PRIE RN P 2R AR DIRE, AT SCHF A o 2 SR &K
FPGA ‘&7 .

J2 3 Timing Constraints Editor )75 2\ W i :

1. WARE FGPA TE, fEHf=rh, 1k4% “Tools>Timing Constraints
Editor” , i, FEIEN File>new n#k /# S :

2. s FPGA TR, fEid B HX, X “Timing Constraints Editor” ,
I Timing Constraints Editor <= H 4 n#k TR AR SR 7 Timing
Constraints Editor 5 1fi, 411l 6-3 Bz,

A R P A R g AR VR T U7 %, 1§25 _(Gowin &7/ 29 K757 )
6-3 QT4 S H

A Gowin Timing Constraints Editor - C/Usersfroot/Documents/fpga_project_12/srcffpga_project_12.sdc = |5

Fle Constraints Reports View Help
=

Fetlist Tree & X |Timing Constraints Clock Name Type Period Frequency Rise Fall Divide by
Pe @) | Clocks [kl . Base 10ns 100MHz 0 5
— Clock Latency I ¢
4 Y test Clock Uncertainty
Ports (6) Clock Group
Nets (14) 1/0 Delay

Primitives (11) 4 Path

False Path
Max/Min Delay
Multicycle Path
4 Report

Report Timing
Report High Fanout Nets
Report Route Congestion
Report Min Pulse Width
Report Max Frequency
Report Exception

Set Operating Conditions

Conzole J x

create_clock —name clkl -period 10 -waveform {0 5} [get_ports {dini[1]}]

6.4 Simulation

TEHEA FPGA BB AE T, (i AT EH IR, E T8 A 10
TG 75 B hae i B (AT B, SRERIE RTL Wit Dhee B 745
&G T B AT A B U B, VAL AT R A 26 )5 25 28 14F 2 18] I ZE B I75 10

H Rl Gowin =B & A3 AT 811, ThEEAT B AN 407 B o FH B0 &
25, WIRHE=J7) L E, W Modelsim £,

& Gowin YR FAFFH S HA~ “Tool” MR+ &S “Simulation”
DA E TR, ki 6-4 k.

!
X T =77 7§ TE License, &% =77 HHiE.
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6.5IP Core 74 %% (IP Core Generator)

& 64 BEMiE TR

| Ele Edit Project | Tools | Window Help

[ | U5y | o= ¢ StartPage i
i <5 Synplify Pro g x
I Design Summary <4 IP Core Generator ”
+ [ User Constaints Rty P.ro_]:ect C:\Usersroot\Documen
.':‘I FloorPlanner 7 Timing Constraints Editor File:
= W Timing Coust Simulation L Start Simul?a-ticrn ) ~4-PBGAZ50-0
4 (O Synthesize (Synpl Gowin Analyzer Oscilloscope Specify Simulation Tool
Synthesis Rep S— a
Netlist File | 7+ Qptions.. [

A5 BLINE B 75 B ) 2 SCAAE Gowin\1.8\Pnnlib\ K, prim_sim.v & Zh g1 &
FESCA, prim_tsim.v A2 I R L SO . ST =07 M LR B THEYHE B X
MREAE RN, 1655 =2 IR X F.

6.5 IP Core 2428 (IP Core Generator)

SUG100-1.5

IP Core Generator 1. H 3 E T = A sL A i & = # AR A%Z DL & =
RATHT P, @ T HEM=A S weit 2 f5, P Az se A B sz )
BT EIThRE . HET IP Core Generator 8345 J5 15 48 ¢ 1 Module #B4 F12
ZBTHA I IP Core BN KA A 70, Wil 6-5 s

I8 S A T Tools N4 “IP Core Generator” JA 3] IP
Core Generator T.H, #17 IP AT,

HAREEAS 1P 8 FH 771, 15 275 SR (Gowin IP #2774 1AM 15 ).
6-5 IP Core Generator 5+

»

Mame

4 Hard Module
4 Block Memory
&% DP
is ROM
iw SDP
% sp
4 CLOCK
DLL
o OSC
i PLL
4 Dsp
ALUS4
MULT
MULTADDALU
MULTALL
PADD

m
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6.6

[
=]

IEESY

L3 HT{X (Gowin Analyzer Oscilloscope)

< |

4 13C

&5 13CSDR

4 SPMI

& SPMI

4 User Flash

i 4 User Flash
Soft IP Core

4 CAN

CAN

4 DDRx

4 DDR
DDR Memory Interface
DDR PHY Interface
L DDR2
DDR2Z Memaory Interface
DDR2 PHY Interface
4 DDR3
DDR3 Memaory Interface
DDR3 PHY Interface
4 FIFO
& FFo
i FIFO SC
4 13C
I3C DDR eXtension
[3C SDR
4 MIPI
MIPI RX

MIPI TX v

4 Math v

i CORDIC

Complex Multiplier
i va Divider
ins FFT

4 Microprocessor System

4 Hard-Core-MCU
Gowin_EMPU
4 Soft-Core-MCU
ihs RiscV N25

4 PSRAM

PSRAM Memory Interface

4 RAM Based Shift Register

i1 RAM Based Shift Register

] SDRAM Controller
SDRAM Controller{With embedded
s SDRAM Controller{With external SC —

n |

m

L

m

!

E IS Hard Module 8% Soft IP Core Jyi%k# 47 device N3,

6.6 S -ELIFEE T (Gowin Analyzer Oscilloscope)

SUG100-1.5

BILER AN (GAO) & w5k | A

.-

A

WA 5 4
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6.6 o (LR B 43 M1 (Gowin Analyzer Oscilloscope)

SUG100-1.5

T TH, BRI P EInSEE Mt S 5 2 BRI PR, PRadii
1T RS i e A, S st 3R

GAO .#5 Gowin Core Inserter 1 Gowin Analyzer Oscilloscope /> 1T.
H.. Gowin Core Inserter FZH THUE A5 BECE BRI, XLEEM(E R
FEEET R B il ook ik 30;  Gowin Analyzer Oscilloscope
I JTAG £ MEEHR A H AntEft:, ¥4 Gowin Core Inserter % B[R AFE (S
5 PR CH B s 3 T B H R

A5l GAO i, HRAETLEEHXHE GAO BLE X (.gao), TJTHC
EICA I, & 6-6 .

& 6-6 GAO EL B A

Options | Capture Optisns

nnnnnnnnnnnnnnnnnnn

nnnnnnnnnnnnnn

AAAAA g Dusign Sumaary & e project L. o

Be B SO 2 5, fESEHES T, %k “Tools > Gowin Analyzer
Oscilloscope, TH Ez Y- FMAELZE I T H, WK 6-7 Fix.
6-7 GAO F1i

Gowin Analyzer Oscilloscope

Cable: |Parallel Fort (LFT) « i.”’

=) [ |

Configuration
Devies
[] Ensble device chain
Target Device Device IRCode
Capture
Storage Size: 1024 Window Funber Capture Anount: 1024 = Trigger Pos s
Trigger Exp
exp0: MO

Match lnit

Match Unit ~ Trigger Port  Match Type Function

MO Trigger 0 Basic

FELZ AR AT A A B B AV R VATE 275 _(GOWIN A=2022°45 77 Hir (A
S1GE ).
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6 =IRBIER TR 6.7GPA Ij3E/0#1 T. B (Gowin Power Analyzer)

6.7 GPA h#ES TR (Gowin Power Analyzer)

YRR LH (GPA) R P SRRl BERERA I ThRE A, $R AL T
FHE M RERI P AARYE LR e A A A B, il B it
RISEPRTEDL, s DIAR AT RS (K ThAE 7 M 48 SRASHAE R o

HAT, GPA THRMRZNE LN ERE X/ (gpa) Jylkit, 2 ERA

TR
6. EHMFTHEEHNX (Design), Hidi “File> New...” , T “New”
X HE ;

7. &#E “GPA Config File” , fE#HME NHIEE “Name”;
8. Hili “OK” , RIW[{E “Design” % K& 2H 2 i) GPA Config File;
9. Wilixt#, IR HHmEX SR “GPA Config View” B e fid &,
Wik 6-8 Fizw .

6-8 GPA FL B TH

General Setting | Rate Setting I Clock Setting

Device

Device: GH1H-1-QFF45-6

Operating Condition: COMMERCIAL - Process: TYFICAL -

Enviromment
Ambient Temperature: 25 000°C 2| (-40°C-100°C)

[[] Custom Theta Jh: |25 000°C/% [
Heat Sink

@ Home () Low Profile () Medium Profile () High Profile () Custom

Custom Theta SA: |25 000°C/% |

Board Thermal Model
3) Home Custom Typical
Board Temperature: |25. 0007 S| -40C-100C)

Custom Theta JE: |25 000°C/% |5

Voltage
VOO 1140V 5 (1. 14¥-1.28¥)

VOCX: 2,500V 5| (2.5¥-3.3¥)

[ Start Page | G GPA Config View B |

AR F IR TRIECEME M 5%, 63 %_(Gowin #8757 #r 1 AN
S 15D

6.8 PRIFfikERH IR 1Lt SRtEeR

BAF A WIS — A ASCI S, Hg™ 44 Jv.mis HI TR
SUHEOR, A AR RIS AR SO, HI LA E A7 fif # T A bk T Y
FIURME -

PAFAE BRSO 1 SO 44 J9* . mi(file_name.mi), SO —4TAK
— BT, AT BN AE ik LT AN AR A AR B E IR Address
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6 mIRHAF AR TR

6.8 AT il B VAR AL L1945

SUG100-1.5

Depth; FIKACRE MG ICHE 20407, BV NAFRIEEE 58 Data Width.
bt N BB RUGEE, RATHEE AR, RAAEE

o AF Gl SRR A SO AR SR k. o aEEf L AL SR R

;o mi XN ERS W
1. it (Bin File)

Bin SOl % 0 A 1 A SCAR SO, AT B A Al AR bk

TRIE, FIBURRAT it & 1O Bdle 96 %

#File_format=Bin

#Address_depth=16

#Data_width=32
00001100000100000000100100010000
10000000010010000100000001000000
01000000100000001000000010000000
00100000100001001100000011000000
00000100000001000000010000000100
01000010001010100000101000001010
00100010010001000000010001000110
01000101000001110000010101000001
01100100001001001000010000100100
01001001010010010010100101001001
01100101001001010000010100100101
11000001101001010000010110100101
01001000100010000010110000001100
10000101001011010100110100101101
01101100001100110000011100011001
00001001001010010100000110010000

2. TNt (Hex File)

Hex (45 Bin SCPFRS AL, o8kl 8 O~F 4k, 1T HAURAA#

#File_format=Hex
#Address_depth=8
#Data_width=16
3A40

A28E

0B52

SHOHBEIRE, AT B R AR, AR S B B T
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6 mIRHAF AR TR 6.8 A A s W] Uh 6 SCA T i 2

1C49
D602
0801
03E6
4C18
3. rHbbEH S (Address-Hex File)

Address-Hex S 75 SO oo 2 s s O ik A B s A AT 18 3%
ik AN B2 TSk £ O~F ik, AT E SATI L, B 55
R, O RS NS F b A 3 T Ie %, A e B R BRI
HHE 4 0.

#File_format=AddrHex
#Address_depth=256
#Data_width=16
9:FFFF

23:00E0

2a:001F

30:1E00

i BAFAE AR A IR A SO 1 G2 UORTE B B SCPE CmiD D9 s, 4146
WA g s BAR D SR h -

10. £ THEEFX (Design), B “File> New...” , T “New”
W
11. %+ “Memory Initiazation File”, #1& 6-9 i/ iy “OK”, 7E#H
(1) New File $2/~HE P IS Y460 U144 75 i “OK”, tnfE 6-10 Jir
s A sl 6-11 o MAIaa b SO FBCE S, SR iR 7 R A S
WIUEAE, A DR 70 BC B AT AR A ST RN FIARE % 2K
12. 5 W& S A T B AT 4610 SCAF D Depth AT Width, DU 2 3
SRR N G R E R T AN S v

e Depth 1 Width Z 5 ] ' ££ IP Core Generator %[ I fiTi%# BSRAM [f]
Address Depth /& Data Width —#{, # #1531+ Address Depth 5¢
Data Width KT Jtifi_FArE B 1I{E, IP Core Generator 4 2 /R 1R 15
H; %5 Address Depth B Data Width /N T % [ 7L ATk B4, ik
fa e b T R EBRIARIGG N 0, BB 5T “Update”s

® /oA Mk AN EE ) R 2URT DAde 3 kR, oSk, A bk
RIVAYCiaii W

4. FERCE T AR AS R T WG E RIS N, BEANE 22 R4 m] PAXY 3R
& AR B AT R E

B R IARE IR E SRR, A 1. 8. 16 =FhikFE, WK 6-12
FTR;
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6.8 A A s W] Uh 6 SCA T i 2

SUG100-1.5

o RIS IIMIUGERE R LLEIE T FFF SN, wa] CUE A it T W E,
RSB NS A A, & “Fill with 07 ZF84TEE1E 4 0, “Fill with 17
EIeWItEERF A #89 1,“ Custom Fill”FH A DUARIE B 3T HUE B N,
AR T HE B 1 B GRE K 6-13 fias.

5. {RAF X

K 6-9 FITEALSCHF BT New HRNAE

i ™
o New Rl ==

& VHDL File 3
EE; Physical Constraints File
EE; Timing Constraints File
| 5, GAO Config File
| -, GPA Config File

m

] Memory Initialization File

1

Create memory initialization file

| 0K || Cancal

b

B 6-10 FIIHALSCHFTEE New File 1E

r 5
iy New File m
Hame: test .mi -
Create in: O \UszersirootiDesktopil. SIDE testisre

| o0k || Cancel |
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6.8 BRAFAif A WIAA L SCA T2 44

SUG100-1.5

B 6-11 FIZa SCH IR B S

| DA\gewinTask\testIDE\gprj\fpga_project_4isrc\testt.mi
+0 <1 <2 <3 +4 +5 0 A e

00000000 00 00 00 00 00 00 Foty

00001000 00 00 00 00 00 00 Depth 256 5

00010000 00 il 00 00 il il Laziiz

00011000 00 00 00 00 00 il

00100000 00 00 00 00 00 00 View

00101000 00 00 o0 o0 00 00 Address Base:

00110000 00 00 00 00 00 00 Vohue Bece:  [Hex -

00111000 00 00 00 00 00 00

01000000 00 0 0 0 0 0

01001000 00 0 0 0 0 0

01010000 00 0 0 0 0 0

01011000 00 0 0 0 0 0

01100000 00 0 0 0 0 0

01101000 00 0 0 0 0 0

01110000 00 0 0 0 0 0

01111000 00 0 0 0 0 0

10000000 00 00 00 00 00 00

10001000 00 00 00 00 00 00

10010000 00 00 00 00 00 00

10011000 00 00 00 00 00 00 .

< >
6-12 FIHIL B

0 +1 <2 +3 +4 5 +6 + 1 Column

00000000 00 00 00 00 00 00 00 _. 3 Column
00001000 00 00 00 00 00 00 00 16 Column

A 6-13 HE K E

+0 +1 +2 +3 +4 +5 +6 +T
ononcooo N O I NN N S R R
onorvoo0 N O R RN N S R R
ooerocoo N O R S S - C R R
oovcooco K N S O - N G
oovorooo S N S O S O I
[uli}

Fill with 1

01001000 00 a0 a0 o0 o0 00 00




7 IR S

7.1 A7 JA A R

Py LN G T B

o IR PAE FPGA Wit i #E R, BrAz s bERHAL SO DR, TR ] itk
ERARERZITSHE, TAEREZD Gowin mIREAIREH 1 22%, BRilE
FCHR S B AT IR R I S SO B R A DR o MR A
Ak, P A E A f B Place & Route, &E4HCE @ A & I 2 o S
. DI R S5

7.1 HRHERE

SUG100-1.5

iR 2t d, FIH T H B HS R REER . NAEEER.
IR B4, HEHP TSR/ RS Hibst A2 B UL SN &
AR A N pt, BARME BRI A rpt S

FH P Al RS R4S FEIX f1) Place & Route [X, XU “Place & Route

Report” , $THF FPGA TREX N FAG Jo A e 75
7-1 Place&Route Report

e 7-1 s

« PnRM
nR Messages PnR Messages

> PnR Details
= Placer Report Title Gowin PnR Report
. = Resource Usage Summary Tool Version v1.8.1Beta
Synthesis Report
- s GAO Resource Usage Summary | Series, Device, Package, Speed | GW2AR, GW2AR-18, LQFP144, &
Netlist File
4@ Place & Route » 1/0 Bank Usage Summary Design Name top

Place & Route Repart » Router Design File E:\work\DPX9_test\DPX9_9_write_read_1\impl\synthesize\rev_1\DP}

- Global Clock Usage Summary Gao Design File E:\work\DPX9_test\DPX9_9_write_read_1\src\gao.v

+ Global Clock Signals Physical Constraint File E:\work\DPX9_test\DPX9_9_write_read_1\src\DPX9_0_write_read_1

Power Anal Iy Report

Timing Constraint File
Ll Program Devi

= Pinout by Port Name
PnR Report File E:\work\DPX9_test\DPX9_9_write_read_1\imp/\pnr\DPXS_9_write_re

Created Time Fri Jul 06 13:53:00 2018

= All Package Pins

= Memory Usage
Cr\Gowin\1.8\Prribintgowin.exe -do

Command Line E:\work\DPX9_test\DPX9_9_write_read_1\impl\onricmd.do

Legal Announcement Copyright (C)2014-2018 Gowin Semiconductor Corporation. Al rights

- DnD Na#aile
< . ]
Tesien | Process P Start Page [BE Design Sumary 7 DPR9 @ writeread Lrpthtal [ ‘
output & x
Info (FS0002) : Bi!
Info (PWODO01) : Bov
Info (CMoD0B) : Gei
Info (CMoD0B) : Gei
Info (CMoD0B) : Gei e
Info (CMOD0Z) : Generate

Info (CM0ODO1) : Fri
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7 RS S A4 7.2 s R PR

7.2 ImORMERE

i I @ VEAR T 5 S AEAT R 2 e it R 1 J A R ST, B4 11 R SR
JE Ik K DAL AR B S, BRI SCF R84 N pin,  HR(S Bl &% *.pin 3C
o

Pl e 2 #IX ) Place & Route [X, Xifi “Ports & Pins Report”
FTFF FPGA RN R o @ RS, Wl 7-2 Fios.

& 7-2 Ports & Pins Report

{4 GOWIN FPGA Designer - [E:\work\DPXS_test\DPX9__write_read_1\impl\pnr\DPX3_9_write_read_1.pinhtmi] = | E )
7 Ele Edit Project Tools Window Help NEE
Hioc&
- Pin Messages -
) ) Pin Messages
> Pin Details
. min > Pinout by Port Name Report Title Gowin Pin Report
4 @ Synthesize (Synplify Pro)
i (Syreliy . All Package Pins Tool Version V1.8.1Beta
Synthesis Report =
Netlist File Family, Device, Package, Spead | GW2AR, GW2AR-18, LQFP144, 8
4 Place & Route Design Name top
Place & Route Report Design File E:\work\DPX9_test\DPX9_0_write_read_1\impl\synthesize\rev_1\DP
Timing Analysis Report Physical Constraint File E:\work\DPX9_test\DPX9_9_write_read_1\src\DPX9_9_write_read_1
Ports & Pins Report Timing Constraint File
Power Analysis Report PIN Report File E:\work\DPX9_test\DPX9_9_write_read_1\impl\pnr\DPX9_9_write_re
14 Program Device )
Created Time FriJul 06 13:53:00 2018
C:\Gowin\1,8\Pnribin\gowin.exe -do
Command Line E'\worki\DPXS_ test\DPX9_0_write_read_1\impl\pnricmd.do
Legal Announcement Copyright (C)2014-2018 Gowin Semiconductor Corporation. All rights
Pinout by Port Name:
Port Name Loc./Bank | Dir. | Site 1/0 Type |Drive | PUll |Slew| oo
5 - v Mode | Rate "
|
Tesien | Process J Start Page [T Design Summary ! DPXS_9_write_read 1 pin hinl [ ‘
Output 8 X
Info (F50002) : Bitstrea enerati col ete
Info (PWQ001) :
Info (cMo008) e tml® £il mpleted
Info (cMo008) e ! l.tr.html' file completed.
Info (CcMo008) : e ! ad_1.rpt.html' file completed.
‘Infn (CMooos) : e ! R _read_1.rpt.txt’ file completed.
Info (CMO001) : Fri Jul 06 13:53:00 2018 -

7.3 R FiRE

I Py 75 i SR P AP SERL AOI FPAl XDTAS SUAT SO AR 3, BRIAY
A A%

H A=A B AR S G E AL (AR B OREFI (AR 2 ik S I (Al 7
FE BRI (IR A« foe /NI Bl AR 2 Fe K Bl HH B 4SS A 2R3 28 P 4 15 S5 40
BOAEOL TN EIR AR BT, JFR AR KRR .

FI P Al R FE X ) Place & Route X, Wi “Timing Analysis
Report” , #T9F FPGA LFEX R Py, @il 7-3 Aios.
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7 YR SR

ny
04

7.4 JIFEI BT

& 7-3 B FERE A A

{ GOWIN FPGA Designer - [C\Users\liyang01\Documents\fpga_project

impl\pnr\fpga_project_1.tr.htmi]

Frocess

1| Design Summary
4 [ User Canstraints
A FloorPlanner
 Timing Constraints Editor
4 @ synthesize (Synplify Pro)
Synthesis Report
Netlist File
4 @ Place & Route
Place & Route Report
Timing Analysis Report
Ports 8 Pins Report
Power Analysis Report

I} Program Device

» Timing Details

O Hle Edit Broject Tools Window Help

Timing Messages

ng Summaries

STA Tool Run Summary
Clock Summary

Max Frequency Summar)

Total Negative Slack Sun|

» Path Slacks Table

Setup Paths Table

Hold Paths Table
Recovery Paths Table
Removal Paths Table
Minimum Pulse Width Ta
» Timing Report By Analys
Setup Analysis Report
Hold Analysis Report
Recovery Analysis Rep

Report Title
Tool Version

Series, Device, Package,
Speed, Operating Conditions

Design Name

Design File

Timing Constraint File
Timing Report File

Created Time
Command Line

Legal Announcement

m ]

Start Page

o
[

‘ ﬁTA Tool Run Summarv:

Timing Messages

Gowin Timing Analysis Report

v1.8.0.02Beta

GW1N, GW1N-4B, PBGA256, 6, COMMERCIAL

counter

Ci\Users\iyanga 1\Documents\fpga_project_1\impl\synthesize\rev_1\fpga_project_
Ci\Users\liyang01\Documents\fpga_project_1\src\fpga_project_1.sdc
C:\Users\liyang01\Documents\fpga_project_1impl\pnrifpga_project_1.tr.html

Thu Jun 07 10:28:17 2018

C:\Gowin\1.8\Pnr\bin\gowin.exe -do
Ci\Users\iyanga1\Documents\fpga_project_1\impl\pnricmd.do

Copyright (C)2014-2017 Gowin Semiconductor Corporation. All rights reserved.

Timing Summaries

m ]

Tesign Samary

oz B |

fpga_project_I. tr. htnl

: Physical Constraint parsed completed.

Design | Process v

Dutput

Info  (PADOCE) : Frocessing meclist completed.
Info (CT0002)

Info  (PRO001) : Flacement in progzess.

Info (PROO0S) : Routing in progress. ..

Dutput | Brrer | Weming | Iafe

74 DR E

TAE Mty 22 2R B A P B

VEEL, FEBI PR B S AR TR

EVRIEE s

WRAE B R PR — D TS A9 DA

EEELX 1 Place & Route [X, X “Power Analysis

Report” , AJ4TH FPGA TFEX M I DiFe stk sy, Wil 7-4 fros.
HRUFE W ER, 1§2% _(Gowin ZJFE 7P 1AM 755 )
& 7-4 DIFE iR

s GOWIN FPGA Designer - [D-\wser-bakit B.1IDEVIDE_post0710%mph ornl] =i -]
¢ File Edit Project Tocls Window Help N
S &
Procass. 8% (
I Design Summary
# [ User Constraints Power Messages
Power Messages
FloorPlanner Power Summary L
Tawing Comstraints Edior Power Information Report Tide Gowin Power Analysis Report
+ © Plsce & Route
Thermal Information Tool Version v1.8.18eta
Place & Route Report
Timing Analysis Report configure Information Series, Device, Package,
iming Analysis Repo Speed, Operating Condtion, | GW1N,GW IN-9,PBGA256,6,COMMERCIAL TYPICAL
Ports & Pins Report Supply Information Proces
Power Anslysis Report Power Details Desion Name top
Program Device Power By Block Type Desion File D:\user-bakiUsers\root\Desktop\1.8. LIDEVIDE_postd7 10\srcidpxd.vm
Power By Hierarchy Censtraint File
Power By Clock Domain Pawer Report File D:\user-bakiUsers\root|Desktop\1.8. LIDEIDE_postd? 10\mpl\pnridpx3 power html
Created Time Thu Aug 16 15:15:17 2018
D:\Gowin|1.8\Pnripin\gowin.exe -do D:\user-
e bak\Users\yaotiDesktop\1.8. IDEVIDE_postd710ymplignricmd.do
Legal Announcement Copyright (C)2014-2018 Gowin Semiconductor Corporation. Allrights reserved.
Power Summary
Power Information:
Teocess | Timicn Start Fage [T Design Swmary [ g8 gt hinl dpud power hinl B
Outgut 5%
O\impl\pariena. do -
Info IDE_posi sre\dpxs.vm® |
Infe t\Desktop\1.
Into
nte Placenmen -
Output | Error | Werming (5] | Info

SUG100-1.5
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3% A SynplifyPro J& 1 K 387w

B 5% A SynplifyPro B X f87R

Al wERMAIER

full _case

T Verilog T case 5], RUIFTA T REAIPRE O, A LA
AR IRAFE 5 H .

BE

object /* synthesis full_case */ ;

Pi B3

object Ay case. casex. casez.
parallel_case

U T Verilog ' case 15%7], RMIAM —NIATIZ BIEFEEEH, A ML
VR BT A

A

object /* synthesis parallel_case */ ;

BB

Object 7] 4 case. casex. casez.
translate_on/translate off

MTAREHAZRE AT, WE B . fELRan, ERAN R T E K
A3 AR g, IRl R] AT AE PR GRS i N — B AR

%

[* synthesis translate_off */
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F43% A SynplifyPro J& M f 87w

code
[* synthesis translate_on */
syn_encoding
sl 1% H BB 77 2
BE
object /* synthesis syn_encoding = "value" */ ;
i B
e object RIRETFAEAE s
e value FJ{EELHE:
- default: Z& T R4 Hhk g% 77 U LLIA B bF L Re 45 R
- onehot: KRGS SIS TT 2
- gray: %ﬂa%%ﬁ%%ﬁ%ﬁﬁ;
- sequential: KM A4 s
- safe: WARERIAAE—ANRESEHEI ERIE A,
- original: WEMILTTI, (HRBARRSHATIRSHAT AT AT
syn_keep
TRUEZ 4R E 1 wire FEZEE AL TP IRFEANS, Aopilitl.
BE
object /* synthesis syn_keep = 0|1 */;
BB
object & wire ¥ reg = X % .
syn_hier
PEHIEACAL R % —> Moudle 8k Component S5 (134 F () 2 AL AL B, %8 P
CIDiEl a7 R VE 2y 1871
A
£ FDC X+
define_attribute {object } syn_hier { value }
define_global_attribute syn_hier {flatten}
£ Verilog 3 #EH
object /* synthesis syn_hier = " value " */ ;
E VHDL
attribute syn_hier of object : architecture is " value " ;
L
syn_hier F{EfL$5:

o soft (HE1H): Synplify g Ll st, HEgmfe e il #oc;
o firm: R IHHICHI A AL cell BBk A, RELmE E R8T,
o hard: EREAREE BT R TT I AL H LR R E BT
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F43% A SynplifyPro J& M f 87w

o fixed: PRAFKITHAICHIFEIT, [ B Ik T A B UL BAT I ES )2 Ul SR £ B i 11
fHEsANP

o remove: ERRFAINZEMEMZIR, (HAR M HEARE R P IT;

e macro: JUASLREA BT AT 45

o flatten: EFRFTHIKTIZBIEEZIRIZXAZ, Wl flatten FHADAE 451
F . tn flatten,soft 25T flatten; flatten,firm ALK T & M FT7E E IR A 2%,
B T BT 1K) LTI BE O I R0 L cell IARAL; flatten,remove PRI 1L AL 45 &
PERTTE 2 A& T Z IR BT A 2R, TEARJE 75 B 128 1 B AE 12 75 B )X

— R 1.
loop_limit
fE verilog LA, HEMARE R AR, WHF—NEES, f5EMAEAE
BT PR

BE

beginning_of loop_statement /* synthesis loop_limit integer */;
syn_looplimit

FE vhdl ST, BRI R AR, AR — N EIN, fREmA ST

IR BT RR ] o

B

attribute syn_looplimit : integer;

attribute syn_looplimit of labelName : label is value;
syn_noprune

PR ALRFF— A B Z > component (RIS, 1 AN ooy HY BE 15 58 BRI o — LA
B IZARZRIOE OUR R A i o 11 (1 S48 2 AN EDIF ST Rl ER -

B

E FDC (A

define_attribute {module|instance} syn_noprune {0|1}

£ Verilog 3 1EH

object /* synthesis syn_noprune = 1 */;

E VHDL

attribute syn_noprune : boolean

BB

Object 7]y module. declaration, 5% 7] 7] Ay Sz .
syn_preserve

FHAESRC R AT () 75 A7 ds BB, AEREER b i) Bl 25 77 as LR AL DR A2l
Al I ORFERE E BIRESHLEE DAL ANZ)

EE
7t Verilog SCHEH

object /* synthesis syn_preserve =0 |1 */
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F43% A SynplifyPro J& M f 87w

E VHDL SCfFH:

attribute syn_preserve of object : objectType is true | false;
i B

object Al NF A7 E M55, B3 7] Module.

A2 ST RM AR

SUG100-1.5

syn_allow_retiming
T8 A AE a2 15 0] 2 1 2 B AR LASE R M RE
BE
£ FDC (A
define_attribute {register} syn_allow_retiming {1|0}
define_global_attribute syn_allow_retiming {1|0}
£ Verilog 3CHEH
object /* synthesis syn_allow_retiming =0 | 1 */;
E VHDL S+
attribute syn_allow_retiming of object : objectType is true | false;
syn_ramstyle

SR RAMS (95017, 028 77 B 25025 . K2R LG T RAM
Y% B35 % o RAM SC0144

A

fE FDC (A4,

define_attribute { signalname [ bitRange ]} -syn_ramstyle value

define_global_attribute syn_ramstyle value

1E Verilog X4+ -

object /* synthesis syn_ramstyle =value */

E VHDL S

attribute syn_ramstyle of object : objectType is value;
syn_romstyle

fiE ROM MBI ZER, 7 Synplify 1 case i&H)4E i ROMs & /0 RiA —2
PIHEERE IR T A RUE, iR HZ T ROM 523 ROM,

Bk
{£ FDC (4.

define_attribute { romPrimitive } syn_romstyle {logic | block_ram | Ipm_rom |
MLAB | distributed | select_rom }

7t Verilog SCHFH
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F43% A SynplifyPro J& M f 87w

SUG100-1.5

object /* synthesis syn_romstyle = "logic | block_ram | Iom_rom | MLAB |

distributed | select_rom" */ ;

7E VHDL 4.

attribute syn_romstyle of object : objectType is "logic | block_ram | I[pm_rom |

MLAB | distributed | select_rom";

syn_replicate

FECAI 5325 1) 27 47 2 RO B2 11 o

BE

£ FDC (A

define_global_attribute syn_replicate {0 | 1};

1t Verilog X4+

object /* synthesis syn_replicate =1 | 0 */;

E VHDL

attribute syn_replicate : boolean;

attribute syn_replicate of object : signal is truelfalse;

syn_direct_enable

e B R S E — SR INBERE net 20 IC g E A7 RTINS RS, SRS

VNN EES (B 54y RutE R

B

£ FDC (e

efine_attribute {object} syn_direct_enable {1},
£ Verilog 3 1EH

object /* synthesis syn_direct_enable = 1 */;
E VHDL

attribute syn_direct_enable of object : objectType is true;

syn_direct_reset

FEHIR TR R E — 2% net A4 1R € W [P A7 BT Y reset Ui
A

£ FDC (e

define_attribute syn_direct_reset {0|1};

7t Verilog SCHEH

object /* synthesis syn_direct_reset = 0|1*/;

E VHDL S

attribute syn_direct_reset : boolean;

attribute syn_direct_reset of Object : signal is truelfalse;
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syn_direct_set

FEHIR TR R E — 2% net Zplic4s 48 € M RD A7 M BT Y set i

BE

£ FDC X+

define_attribute syn_direct_set {0|1};

1t Verilog X4+

object /* synthesis syn_direct_set = 0|1*/;

E VHDL S

attribute syn_direct_set : boolean;

attribute syn_direct_set of Object : signal is true|false;
syn_black _box

Syn_black_box #§4 F TR 4 E ik B 255, MR N2 57,
EEREYE D B2 & o

BE

fE CDC (M4

define_attribute { object {syn_black_box}{1}

£ Verilog SCHEH

object /* synthesis syn_black_box */ ;

fE VHDL S+

attribute syn_black_box of object : objectType is true;
syn_maxfan

BB ARG net BUAT A S o 6 e tHAE .

A

£ FDC (e

define_attribute {object} syn_maxfan {integer}

7t Verilog 3 #EH

object /* synthesis syn_maxfan = "value" */;

E VHDL

attribute syn_maxfan of object : objectType is "value";
syn_pipeline

FOVFARG ERAE I 45% J T 0 7 A7 2 1 N\ i o SE I LASR e D36

B

£ FDC S+

define_attribute { register } syn_pipeline {0|1}

7t Verilog SCHFH

'
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object /* synthesis syn_pipeline = {1|0} */ ;
£ VHDL SCff:

attribute syn_pipeline of object : objectType is {true|false};

syn_probe

IR i CABEI AT 100 P 845 5

BE

£ FDC X+

define_attribute {n:netName} syn_probe{probePortname|1|0}
7 Verilog SCAFH

object /* synthesis syn_probe = "string" | 1| 0 */;

E VHDL S

attribute syn_probe of object : signal is "string" | 1 | O;

syn_useenables

77 17 A I b A5 B S Y A7 4

BE

E FDC (A

define attribute {register|signal} syn_useenables {0|1}

£ Verilog SCHEH

object /* synthesis syn_useenables = "0|1" */;

E VHDL S

attribute syn_useenables of object : objectType is "true|false”;

syn_netlist_hierarchy

OUTE T H ) EDIF W2 R AL 2 PTG Y, I TR 4 5 JE k.

B

E FDC (A

define_global_attribute syn_netlist_hierarchy {0 | 1}
1E Verilog X4+

object /* synthesis syn_netlist_hierarchy =0 | 1 */;
E VHDL S+

attribute syn_netlist_hierarchy of object : objectType is true | false;
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PSR B X p S1TIETR

-d | -design <file>
R, FEERANMLRE A RZ AR R I
-p device-package-speed
o TIENI, fRERMIEITER, 1T device. package 1 speed {5 ..

® IR\ Device: GWIN-4, Package: PBGA256, Speed: 5.
e nfl: gowin —d test.v —p gw2a-55-PBGA1156-6

/IDevice:GW2A-55; Package: PBGA1156; Speed: 6.
I 85 . gowin —d test.v —p 55-1156-6
-c | -cst <file>
AT, f8E Y ERL) R S cst.
-sdc <file>
AT, 4R PR sdce.
-cfg <file>
o HLIEN, fRERCE MR, AT WE S HE I bitstream SCAFHTELE ;
o FARFEENMA, SIEEATHRT “device.cfg” KIS

o HAFAEZ U BURAE ok T, s BB A R B ST, BRIAL B S
AR A 22 368842, an/x.x/Pnr/cfg.

-0 | -out <fileName>

o TN il T OTE MR R
o LIRIRELIA fileName, MAIEEFIZ I 4B ARSI
B 0",
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-top_module
AT, i E R BRSO top module.
-bit <fileName>
® m[IEI, AR bitstream (A
o FiRIEENXMA fileName, N bit SXHAZERINA: HINME 47

+ “.fs” o

-ibs <fileName>

e H[iEIN, Ak IBIS i

o iRIBTE M4 fileName, NI ibis SCHEALA BRI : B NN R S48
+ “ibs” .

-gao
AR, F85E GAO flow Xf4.

-gpa <fileName>

o H[EIN, BRINAERL html A% K ThEE D Hr ik s
o FiRTRE M4 fileName, WIIFES TR 5 ST A BRI BT AR S
HHI% 7+ “_power.html” .

-t | -tr <fileName>

AT, A2 R html kg U 2 i i
-tt <fileName>

AT, A OO I 7 B i o
-s | -sdf <fileName>
o HIEMN, ARRUH T 0 L A ARAE IE I SO

o FORFRE M4 fileName, JUIE N SCAFI ST BRI B N RS
145+ “.sdf”

-ocst | -oc <fileName>

o TIEIN, Apk port (L HALE A B S

o RIRENXM A4 fileName, WZJHALEAE BRI ANy : A MR
A4+ “lio.cst” s

-timing

AT, 1247 timing driven ZAE.
-posp <fileName>

o HIEIH, AR R £k T instance AR RS B, H T floorplan i
B

o FiRfRE M4 fileName, NCEAS BRI SCHLZBIANN: i NR SO
K147+ “.posp” -
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-prep <*.posp>

AL, 45 5E posp 18 5.
-init_all

FIETR, ¥ Instance MIFTA Initial {2 % H 24 BRI HEE N R 4
-warning_all

eI, ENFTE warning 58 .. HAMEHESEL RIS 10 %
warning & &..

-do <cmdFile>

o DRI T A B A F, lid-do It E 1%
e design.do XN ESHEFEH:

-d design.vm
-p GW2A-18-PBGA484-6
-cfg device.cfg
-bit
-tr
-h
AT, @id S H-h | --h | -H | --H | -help |--help #iH! gowin #EE B
-v |-V
AfIET, R Gowin MRAE S
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B % C pawmn

LLR it demo.v 9, iz el 456 ] Gowin =Y A«
module demo (clk_50M,rst_n,led);

input clk_50M,;

input rst_n;

output[3:0] led;

reg[3:0] led,;

reg[24:0] cnt;

reg clk_led;

always@(posedge clk_50M or negedge rst_n) begin
if (Irst_n) begin

clk_led <= 1'b0;
cnt <= 25'd0;
end
else begin

if (cnt == 25'd2499_9999) begin
clk_led<=~clk_led;
cnt<= 25'd0;

end

else begin
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cnt <=cnt + 25'd1;
end
end
end
always@ (posedge clk_led or negedge rst_n) begin
if('rst_n) begin

led <= 4'h1,;
end
else begin
led <= {led[2:0],led[3]};
end
end
endmodule
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C1EITIE

19 Gowin =B 2% 5.1 FiiE TIE R 5.2 FT I TRE#E S RTL L2
JEAIN demo.y B TR, EEG&HENE, WK C-1 .

& C-1 Gowin =B/ IDE

{4 GOWIN FPGA Designer - [Design Summary] = |
| Ele Edit Project Tools Window Help BEIE
3 S &
Desien & %
4 77 test - [0 \wser-bak\Usersiroot i
‘ GWKN-LVAIFEESBC;A.S ........ Project File: D:\user-bak\Users\root\Desktop\1.8. LIDE\test\test.gprj
4 | Verilog Files Synthesis Toal: Synplify Pro
testv
festest Part Number: GWIN-LV4PG256C6/15
Series GWIN
Device: GWIN-4
Package PBGA256
Speed Grade: C6/15
Core Voltage: v

Desien | Frocess ¢ Start Page | { Design Sunmary ‘

C2iBiTIiE

a7 TAE 7 U h

1. 7 “Process” %1, Wi “Synthesize (Synplify Pro)” i3 #ii s
AIEEE “run”, HEATH P RO SR E AR,

2. A5G, Wil “Place&Route” B #i AR A BEIE R “run”, 3HT

CEE JE W R AR f A 2k e 7 4 bitstream SO, T C-2 Frox.
C-2izfT LREFH

A7 GOWIN FPGA Designer - [E:\work\DPX9_test\DPX9_9_write_read_1\impl\pnr\DPX9_9_write_read_Lpin.html] SHACE X"
 Ele Edit Project Iools Window Help REE
] Hica
Process - B3 =
1] Design Summary |;|
4 [ User Constraints « Pin Messages - L
h ) Pin Messages
A FloorPlanner - Pin Details
“ Timing Constraints Edi-- .
- s Pinout by Port Name Report Title Gowin Pin Report
4 @ synthesize (Synplify Pro
o (Synplity Pro) < All Package Pins Tool Version v1.8.18eta
Synthesis Report
Netlist File Family, Device, Package, Speed GW2AR, GW2AR-18, LOFP144, &
4 @ Place & Route B e top
Place & Route Report Design File E:\work\DPX9_test\DPX9_9_write_read_1\impl\synthesize\rev_1\DP
Timing Analysis Report Physical Constraint File E:\work\DPX9_test\DPX9_9_write_read_1\src\DPX9_9_write_read_1
Ports & Pins Report Timing Constraint File
Power Analysis Report PIN Report File E:\work\DPX9_test\DPX9_0_write_read_1\impl\pnr\DPX9_9_write_re
1 Program Device
Created Time Fri Jul 06 13:53:00 2018
C:\Gowin\1.8\Pnr\bin\gowin.exe -do
e L E'\work\DPXQ_test\DPX9_9_write_read_1\impl\pnricmd.do
Legal Announcement Copyright (C)2014-2018 Gowin Semiconducter Corporation. All rights
Pinout by Port Name:
. o - Pull | Slew
Port Name Loc./Bank | Dir.  Site 1/0Type Drive| g pote  Clamyp
gl 0 v
Desien | Process p Start Page RE Tesign Sumary MNP S writeread 1 pinhtl [ ‘
e [Sartece ) %
Info (F50002) : Bitstream generation completed. -
Info (PWO001) : Power analysis completed.
Info (CMO008) : Generate 'DEX9_Q_write_read 1.power.html' file compleved.
Info (CM0008) : Generate 'DPXS 9 write read l.tr.ntml' file completed.
Info (CMO008) : Generate 'DPXS_9 write read 1.rpt.html' file completed. i
Info (CMO0OE) : Generate 'DEXS_S_write read_l.rpt.txt' file compleced. [
Info (CM0001) : Fri Jul 06 13:53:00 2018 -
Output Error Harning Infe

C.3 T# 4R
PR T 3807 R
1. BiTRA R G, 15 “Process” &M, i “Program Device” B
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HARESE “run”, ITIF R ARSI, W C-3 fw,

H P2 A2 1 bitstream ORI R #28;

2. B “ 0 7, HAT bitstream SCAE T E
YE!
o  JRA[IEIT PLF 7 A FHAT bitstream T :

o fHFIPRTENE F5,
B C-3 TE&F |

TRAZE3NN

s Programmer 2 -— = = | E i)
File Edit About

= =

Enable Family Device Operation File Checksum  User Code

1 GWIN GWIN-4 SRAM Program CifUsers/root/Documents/fpga_project 12/... CSF6 0000CSF6

o 3
Output B X
Ready
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